fortéso

BLIGz

User Guide

4
orteBio o
'fA Division of Pall Life Sciences Life Sciences




BLItz System User Guide
P/N 41-0178 Rev C

Copyright © 2015 Pall ForteBio, Inc. All rights reserved.




page 1

Table of Contents

Chapter 1: Launching the ForteBio GxP Server for the
Welcome......coovvviiiiiiiiininnnn, 1 FirstTime. ......ovvviieneiiiinnnnnns 28
Introduction................ccccovviiin... 2 Assigning Additional Users............ 28
BLltz System Package .................... 2 Assigning Privileges by Group........ 30
Conventions Used in This Guide........... 4 Creating Projects for Sorting Events . .30
BLItzSupport............cooiiiiiiiiii... 4 Setting Constants for Advanced
Options. .....c.cveiieiiinnnannnnn. 31
Chapter 2: . Viewing Events in the Audit Trail .. ... 32
BLItz System Specifications .......... 5
BLItz System Specifications ............... 6 L'aun.chmg the BLitz Pro CFR Software for the
firsttime ......oovuiiuieiiiiiiiaennannn. 33
Basic Functions of the BLItz System ........ 8 . o
Restricted Privileges..................... 34
Biosensors. .......o.uiiiiiiiii 9 .
Compliance Features.................... 34
Dipand Read Assays.................. 9 o ) .
Viewing the Audit Trail. .............. 35
BiosensorTypes..................... 10 o
Electronic Signatures ................ 35
BLITechnology ..................... 12 . . .
Changing Projects During a User
SesSioN ... 36
Chapter 3: )
BLItz Installation and Usage.......... 13 Changing the User Password. ......... 36
Installing the BLItz System .............. 14 Locking the Application. ............. 37
BLlItz Pro Software User Interface ....... 16 Ending a User Session................ 37
Toolbars.........cccovvvvviinnnaa.. 17
Chapter 5:
Menu Commands................... 18 Working with Experiments . ......... 39
feons ..o 24 INtroduction .................ccceeu... 40
UninSta”ing the BLItZ PI’O SOftWGI’e ..... 25 Accessing BLItZ ExperimentModes ...... 40
Defining Experiment Types........... 41
Chapter 4:
21 CFR Part 11 Compliance. ......... 27 Before You Start Your Experiment ........ 41
BLItzPro CFRSoftware ................. 28 Navigating Through the BLItz System42
ForteBio GxP Server Module ............ 28 Hydrating Biosensors ................ 42

Running a Quick Yes/No Experiment.... .45

BLItz User Guide



page 2

Creating a Standard Curve ............. 52

Running a Quantitate Sample
Experiment................coooiiiiialn, 60

Running a Basic Kinetics Experiment. ... 67

Running an Advanced Kinetics

Experiment.............ccoviiiiiiin... 76
Managing Reports ..................... 83
GeneratingaReport ................ 83

Viewing Reference-Subtracted Data. 83

Viewing Inverted Data . ............. 84

Appendix A:
Running the BLItz Pro Software on
Computers Running Octet Systems. . 87

Running Only the BLItz System ......... 88
Running Experiments on Octet and BLItz
SYStems ..o 88
Appendix B:

Troubleshooting ................... 91

Troubleshooting BLltz System Errors with an
OctetSystem .........cooeveiiiinen... 92

Scenario 1—The BLItz System Cannot
Initialize Successfully................ 92

Scenario 2—The BLItz System Is Not
Recognized......................... 92

BLItz User Guide



page 1

CHAPTER 1:

Welcome

3340 Yo 11T { o o e 2
BLItZ System Package .. ....iii e e e e 2
Conventions Used iN ThiS GUIdE . ...t e et i 4
BLIEZ SUP PO . ettt e e e e 4

BLItz User Guide



page 2 Chapter 1: Welcome

INTRODUCTION

Welcome to the Pall ForteBio BLItz User Guide. This guide explains how to:
« Configure, install, and operate your BLItz® system and BLItz Pro™ software.
« Set up and run quantitation and kinetics experiments on the BLItz instrument.

This guide contains information on materials required for using the BLItz system, installa-
tion procedure, setting up and running experiments, and performing data analysis.

The guide provides a set of specific instructions in “Working with Experiments” on page 39
based on the Starter kit included with your BLItz system.

NOTE: If you are a new user, we highly recommend that you first perform the
e tests outlined in the BLItz Demo Guide to familiarize yourself with the BLItz sys-
tem operations before embarking on your own research.

For further information on any topic, contact technical support using information provided
in “BLItz Support” on page 4.

We wish you the best in your research!

BLITZ SYSTEM PACKAGE

The BLltz system enables real-time quantitation of solution-based analytes or kinetic char-
acterization of molecular interactions.

The BLItz system package consists of the BLItz instrument, the BLItz Pro software CD,
power cord, USB cable, BLitz Quickstart Guide, BLltz Demo Guide, and a demo Kkit.
(Figure 1-1).

Figure 1-1: BLItz System Package Contents
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o IMPORTANT: Immediately store the sample diluents, human IgG, mouse IgG,
and hydrochloric acid reagents at 2-8°C.

Table 1-1 lists the BLItz system demo kit contents.

Contents Description

Reagents | - One (1) tray of 32 Protein A biosensors
+ 200 pL of 10 mg/mL human IgG stock
+ 100 pL of 10 mg/mL mouse IgG in carrier protein containing buffer

« 50 mL of sample diluent

Accesso- + 500 pL of 0.5M hydrochloric acid for deep cleaning drop holder
ries + 20 black polypropylene conical bottom microcentrifuge tubes
(0.5mL)

«  96-well, black, flat-bottom polypropylene (Greiner Bio-One,
#655209) for hydrating biosensors

+  One (1) drop holder
«  Swab, pack of 20, to wipe drop holder

Materials | - Pipettors, any color:
(Required

" Not 2-20 uL
Provided) - 20-200 pL

+ 100-1000 pL

+ Appropriate pipette tips, any color
+ Lint-free lab wipes
+ Gloves

+ Laptop or desktop computer—Ensure that your computer meets
the following minimum specifications:
+  32-bit or 64-bit Windows XP and Windows 7
«  Monitor resolution of at least 1,024 x 768
+ 1USB2.0port
+ 2.5 GHz Dual Core CPU
- 2GBRAM

Table 1-1: BLItz Demo Kit Contents

For information about BLItz system specifications and basic functions, see “BLItz System
Specifications” on page 5. For information about installing and configuring the BLItz Pro
software to use with the BLItz system, see “BLItz Installation and Usage” on page 13.
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page 4 Chapter 1: Welcome

CONVENTIONS USED IN THIS GUIDE

Table 1-2: BLItz Symbols and Instrument Labels

Symbol Definition

NOTE: A note presents pertinent details on a topic; for example,
general information about tips or alternate options.

IMPORTANT: An important message for instances where the
experiment or procedure will not work if not properly followed.

WARNING: A warning warns you that your actions could cause
irreversible consequences or damage.

Electrical hazard

Heat/hot

Fuse

B> © © ©

BLITZ SUPPORT

Pall ForteBio wants to ensure that you are completely satisfied with the BLItz system and software, and will
address any concerns in a timely manner—it’s our way of supporting your research. We are also extremely
interested in your product feedback and application needs, and would be happy to discuss either with you.

For technical questions or to speak with one of our support staff, email technical support via our online
form which also lets you attach files. You may also contact technical support at:

Pall ForteBio LLC

1360 Willow Road, Suite 201

Menlo Park, CA 94025

USA

Tel: +1-888-628-3875

Fax: +1-650-322-1370

E-mail: fortebio_support@pall.com
http://www.blitzmenow.com/email_support.html

BLItz User Guide
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BLITZ SYSTEM SPECIFICATIONS

Figure 2-1 illustrates the BLItz system components (front and back).

Biosensor
mount
Drop
Holder Power o
Switch 1|H|i Socket
Tube Holder 8 =

Slider ™

fortéso

Figure 2-1: BLItz System—Front and Back

Table 2-1 lists and defines the BLItz system specifications.

Table 2-1: BLitz System Specifications

Specification Descriptions

Equipment + Product Classification: Class 1: Detachable power cord

Classifications + Installation/Overvoltage Category: Category ||
+ Pollution Degree: Degree 2

« EMC Classification: Group |, Class A, ISM Equipment
(EN55011, emissions), {EN61326, immunity}

Environmental « Storage Temperature: -20 to 70 °C
+  Optimum Operating Temperature: 22 + 4 °C
« Safe Operating Temperature: 15 to 30 °C
«  Humidity: Non-condensing 10 to 80% Relative Humidity
+ Indoor Use Only
« Operating Altitude: 0 to 2,000 meters

Compliance CE

Capabilities + Protein quantitation
+ Kinetic and affinity analyses (k,, kg, Kp)
« Binding specificity and cooperativity

- Kinetic screening of proteins, peptides, and other bio-
molecules

Sampling Format Drop holder and microcentrifuge tube

BLItz User Guide
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Table 2-1: BLItz System Specifications (Continued)

Sampling Volume 4 uL in drop holder; 250 pL in tube
Sample Types Purified samples, common culture media, crude lysates
Biosensor Type Disposable fiber-optic biosensors

Optics and Mechanics  1-channel biosensor manifold, one (1) spectrometer

Shake Rate Static or 1000-2600 rpm (default is 2200)

Dimensions 6.8"Hx6.0"Wx8.7"D(174cmHx 153 cm W x 22.2 cm D)
Weight 7.21b (3.3 Kq)

Electrical Require- Power consumption: 8w (18W peak)

ments Mains: AC 100-240V, 0.2-0.1A, 50/60Hz, single phase
Connections Power input, USB data output port

Software BLItz Pro™ software for data acquisition and data analysis

BLItz User Guide
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BASIC FUNCTIONS OF THE BLITZ SYSTEM

Table 2-2 lists the basic functions of the BLItz system.

Table 2-2: Basic Functions of the BLItz System

Function

Hydrating Biosensors—Perform hydration on the bench in the blue
biosensor tray for, at least, ten minutes before use. Use the same buffer
as that in your sample. For more information, refer to “Hydrating Biosen-
sors” on page 42.

Setting Up an Experiment—Select an Experiment type from menu (in
@. the left pane) of the BLItz Pro software, input the experiment informa-
- tion and click NEXT. Then, follow the prompts to load sample and bio-
sensor on the BLItz system.

Placing a Drop of Sample in the Drop Holder
Pipette a 4 uL drop of sample inside the dimple in the drop holder.
r Ensure that there are no air bubbles in the liquid.

Placing and Removing Drop Holder—The drop holder is magnetic and
easily snaps into place. Place the drop holder and press down gently to
ensure a snug fit. Replace the drop holder when damaged or contami-
nated.

N
*‘ \ Wiping sample with a swab (or other lint-free lab wipe)—At the end
L of a run, wipe the sample from the drop holder with a swab, or with the

corner of a folded lab wipe. Rinse with buffer and blot with lab wipe
e | thrice. For deep cleaning, use 0.5N HCl instead of buffer. Follow up with
buffer rinse to remove all HCI.

What is the use of the tube holder?
'.‘ The drop holder is the only sample location you should use in Quick
,"‘ Yes/No, Create Standard Curve, and Quantitate Sample experiments.
In Basic Kinetics and Advanced Kinetics experiments, the tube holder
is recommend for all baseline and dissociation steps, and for association
steps longer than five (5) minutes. Use 250 uL of liquid in the tube for all
experiments.

2 3 | Sliding Drop Holder and Tube to Read Position—Moving the slider to

- the right brings the drop holder in line with the black triangular mark
bt .| and thus, to the read position. Moving the slider to the left brings the
- tube holder in line with the black triangular mark and thus, to the read
position.

BLItz User Guide
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Table 2-2: Basic Functions of the BLItz System (Continued)

Function

Mounting a Biosensor—Apply a biosensor on to the biosensor mount
by hand. Give a final quarter-turn-upward twist to ensure a snug fit. Do
not let the tip of the biosensor come into contact with solid surfaces. Do
not let the biosensor dry in air. This will result in loss of performance.
Keep the biosensor hydrated until ready to use. After mounting a bio-
sensor on the BLItz system, perform the experiment immediately.

BIOSENSORS

Dip and Read Assays

BLItz uses Pall ForteBio’s Dip and Read™ label-free assays. These direct binding assays take
place on a disposable biosensor made from a biocompatible matrix that is uniform, non-
denaturing and minimizes non-specific binding (Figure 2-2). Only molecules that bind
directly to the biosensor surface are detected, providing exceptional specificity for individ-
ual applications, even in crude media.

e | over

ptical layer

Biocompatible
matrix

BLI biosensor
tip surface

Immobilized
molecules

Figure 2-2: Dip and Read Assays
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Biosensor Types

A variety of disposable, off-the-shelf biosensors are available for the BLItz system, making it
easy to run a wide range of assays on the same system. The BLItz system uses the same Dip
and Read biosensors that are used on BLItz's Octet platform, and over four million assays
have been run to date. You can be confident that the assays you run on the BLItz system will
provide the same high level of accuracy and precision. Our biosensors are manufactured in
an ISO 9001:2008 certified facility. To find a current list of biosensors and to place an order,
go to http://www.blitzmenow.com/biosensors.html.

Table 2-3: Biosensor Types

Required Analyte Measured Description
Capture
Molecule
Anti-hlgG-Fc None hlgG, human Fc-fused Binds specifically to the Fc portion of human
proteins IgGs and other proteins containing a human

Fc region. Applications include quantitation
of human IgG and proteins containing the
human Fc region in cell line development,
clone selection, process optimization, and
production monitoring.

Anti-mlgG-Fv None mlgG, rat IgG, mouse- Binds specifically to the Fv(ab')2 portion of
Fab, rat Fab mouse and rat IgGs. Applications include
quantitation of mouse and rat IgG in cell line
development, clone selection, process opti-
mization, and production monitoring.

Protein A None Many human and other Binds with high affinity to the Fc region of
19G types human IgGs. Binds with moderate affinity to
many subtypes of mouse and rabbit IgG.
Applications include quantitation of IgG in
cell line development, clone selection, pro-
cess optimization, and production monitor-

ing.
Protein G None Many murine and other  Binds with high affinity to the Fc region of
19G types murine, rat, goat, and bovine IgGs. Binds with

moderate affinity to many subtypes of
human IgG. Applications include quantitation
of IgG in cell line development, clone selec-
tion, process optimization, and production

monitoring.
Protein L None Most mouse, rat, human  Binds with high affinity to most mouse, rat
IgG and Fab and human immunoglobulins containing a

kappa light chain. Does not bind goat,
bovine, rabbit or sheep IgG. Applications
include quantitation of FAb fragments and of
IgG in serum-based culture.

Anti-Penta-HIS None His-tagged proteins, Uses the Qiagen Penta-HIS antibody to bind

(HIS1K) peptides with high affinity HIS tagged recombinant
proteins. Applications include quantitation
and kinetics of HIS-tagged proteins.

BLItz User Guide
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Table 2-3: Biosensor Types (Continued)

Required

Capture
Molecule

Analyte Measured

Description

Ni-NTA None HIS-tagged proteins, Quantitation and kinetic analysis of HIS-
peptides tagged proteins. Designed for use in buffer
and diluted complex media.
Anti-GST (GST) None GST-tagged proteins, High affinity anti-GST antibody on biosensor
peptides binds GST-tagged proteins. Applications
include quantitation of GST-tagged proteins
and kinetics of proteins and peptides binding
to GST-tagged proteins captured on biosen-
sor.
High Precision Biotin- Proteins, peptides, Streptavidin-coated biosensor. Immobilizes
Streptavidin (SAX) tagged oligos biotinylated antibodies, proteins and nucleic
or Streptavidin pep- acids to form a stable surface. Quantitation
(SA) tides, oli- applications include antibody and protein
gos, quantitation in cell line development, clone
proteins selection, process optimization and produc-
tion monitoring. Kinetic applications include
protein and antibody kinetic and affinity anal-
ysis (k,, kg, Kp), and epitope binning.
Amine Reactive Proteins, Proteins, antibody Second generation carboxylate functional-
(AR2G) pep- fragments ized surface allows covalent coupling of pro-
tides, oli- teins via EDC/s-NHS mediated amide bond
gos formation. Kinetic applications include pro-
tein and antibody kinetic and affinity charac-
terization (ky, kg, Kp). Requires AR2G Assay Kit
(P/N 18-5095).
Anti-hlgG-Fc Cap- hlgG, Proteins, peptides, anti- Immobilization of human IgG or other human
ture (AHC) humanfc  body fragments Fc-containing proteins by binding to the
fusion human Fc region. Kinetic applications include
protein protein and antibody kinetic and affinity
characterization (k,, kg, Kp) and epitope bin-
ning.
Anti-mlgG-Fc Cap-  migG, Proteins, peptides, anti- Binds the Fc portion of IgG1,1gG2a and IgG2b
ture (AMC) mouse fc  body fragments for capture-based immobilization. Applica-
fusion tions include kinetic analysis of antibody-
protein antigen interactions (k,, kg, Kp) and off-rate
screening. IgG3 should be evaluated on a
case-by-case basis.
Aminopropylsi- Proteins, Proteins, peptides Adsorption of proteins and membrane frac-
lane (APS) peptides tions through hydrophobic moieties. Kinetic

applications include adsorption of proteins
and membrane fractions through hydropho-
bic moieties for kinetic and affinity analysis
(ka0 kgs Kp)-

BLItz User Guide
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BLI Technology

The BLI (bio-layer interferometry) technology (Figure 2-3) used by the BLItz system provides
real-time data on protein interactions. The BLItz system emits white light down the biosen-
sor, and then collects any light reflected back. Reflected wavelengths are affected by the
thickness of the coating on the optical layer. Some wavelengths show constructive interfer-
ence (blue), others show destructive interference (red).

A\
BLI signal —
Incident processing ‘I

White
Light

o
)
T

=4
o
T

o
~

Relative Intensity

Oy

0.2

Wavelength (nm)

Figure 2-3: BLI Technology—Displaying Constructive and Destructive Interference

This interference is captured by a spectrometer as a unique spectral signature and is
reported in relative intensity units (nm). Any change in the number of molecules bound to
the biosensor causes a shift in the interference pattern that is measured in real time. This
wavelength shift is a direct measure of the change in optical thickness (nm) of the biologi-
cal layer.

Want to learn more about BLI technology? Call us at 1-888-628-3875 or email at
fortebio_support@pall.com.

BLItz User Guide
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INSTALLING THE BLITZ SYSTEM

IMPORTANT: Users running the Octet system and software may install and

o run the BLItz system and BLItz Pro software on the same computer. For specific
instructions, see Appendix A. For seamless operation of the Octet and BLItz
systems, it is recommended that Octet users upgrade to at least versions
6.4.1.3 and 7.0.1.3 of the Octet software. lease contact the technical support
team by calling 1-888-628-3875 or email fortebio_support@pall.com for more
information.

o IMPORTANT: Install the BLItz Pro software first before plugging in the BLItz
system.

IMPORTANT: To install the BLItz system and BLItz Pro software, you should
o first install the software on your computer and go through the steps outlined
below in the order specified.

To install and configure the BLItz system and BLItz Pro™ software in your lab:

1. Remove the BLItz system, power cord, USB cable, and BLItz Pro software CD from the
box. Place the BLItz system on a dry, level surface with minimal vibration, and away
from direct sunlight.

2. Store the Sample Diluent, hydrochloric acid and IgG reagents at 2-8 °C right away.

3. Insert the BLItz Pro Software CD in a laptop or desktop computer and run the BLItzIn-
stallCD.exe file. For minimum computer specifications, see Table 1-1 on page 3.

4. Click Install BLItz Pro Software (Figure 3-1) to install the BLItz Pro software.
5. Click Install BLItz Driver (Figure 3-1) to install the BLItz driver.

BLItz User Guide
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Thank you for using BLItz!

Contact Us

Figure 3-1: Installing the BLItz Pro Software

6. Connectthe BLItz to a power source and computer using the cables provided. If using a
desktop computer, ensure that the USB port is on the back of the computer. Do not
connect to a USB port on the front side of the computer (Figure 3-2).

Power
Input

& = Data
i 4’7/— Output

Figure 3-2: BLItz System (Back)

7. Place a drop holder in its slot on the BLItz system (Figure 3-3).

-
am— T,

Figure 3-3: Placing a Drop Holder on the BLItz System (press gently to ensure a snug fit)

8. Power on the BLItz system and wait for the Windows plug-and-play manager to assign
drivers.

BLItz User Guide
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IMPORTANT: Keep the BLItz system powered on for, at least, 30 minutes, prior
to running a sample.

9. Run the BLItz Pro software (on the desktop, double-click the BLItz Pro 'd icon).

BLITZ PRO SOFTWARE USER INTERFACE

This section describes the BLItz Pro software user interface (Figure 3-4) elements.

Title Bar

Menu Bar

Experiment
Types —

Status Bar —_|

-
=1 & Untitled - Btz Pro (CFR) 1.2.0.36

i File Experiment

b

‘Welcome

N

Quick Yes/No

AN

Create Standard Curve

™

Quantitate Sample

>

Basic Kinetics

™

Advanced Kinetics

Instrument

% BLitz - Drop. Read, Done.

Security  Help

€

‘Welcome to BLitz Pro™ Software. Always start with BLItz Pro software and follow on-screen instructions.

Support

* Email blitzsupport@fortebio.com

¢ Call 1-855-BLITZ ME

Top Eight Things to Know About Using BLitz

Setting up an experiment

|

Choose Experiment type
from menu in left pane of
BLItz Pro software, input
experiment info and click
MEXT. Then, follow the
prompts to load sample
and bissensor on the BLItz
system

Placing a drop of sample in drop holder

g

Y

-“:

Pipet a 4 ul drop of sample
inside the dimple in the
drop holder. Check to make
sure that there are no air
bubbles in the liquid

Cleaning Drop Holder

<

g

N\

-
—,

0.5N HCI instead of buffer for

At the end of & run, wipe
the sample from the drop
holder with a Swab, or with
the corner of a folded lab
wipe. Rinse with buffer and
blot with lab wipe. Use

deep cleaning. Follow up

with buffer rinse to remove all HCI,

Hydration of Biosensors

perform hydration on the
bench in the blue

biosensor tray for at least
ten minutes before use. Use
the same buffer as that in
your sample.

Mounting Biosensors

Push a hydrated biosensor
on to the mount and give a
final quarter-turn-upward
twist to ensure a snug fit
Do not let the biosensor to
dry. Keep the biosensor
hydrated until ready to use

Placing and removing drop holder

The drop holder is
magnetic and easily snaps
into place. Replace drop
holder when damaged or
contaminated

Ready

™ Project: [n

Figure 3-4: BLItz Pro Software Welcome Page
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Toolbars

Table 3-1 describes the BLItz Pro software toolbars.

Table 3-1: BLitz Pro Software Toolbars

Experiment Description

Title Bar The Title Bar (Figure 3-6) is located at the top of the GUI window page and
refers to the file name and BLItz Pro software version. Until the user saves
the file, the file name is “Untitled”.

L] Untitled - BLItz Pro 1.0.0.151 - =

Figure 3-5: BLItz Pro Title Bar

Main The Main Menu Bar (Figure 3-6) is located at the top of the GUI window,

MenuBar  and displays the main menus available in the BLItz Pro software. See
“Menu Commands” on page 18. for a definition of main menu bar com-
mands.

File Experiment Instrument Help

Figure 3-6: BLItz Pro Main Menu Bar

Status Bar  The Status Bar (Figure 3-7) is located at the bottom of the GUI window
page and displays current system and experiment status. See Table 3-7 for
a definition of the status bar icons.

Ready

Figure 3-7: Status Bar

BLItz User Guide
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Menu Commands

File Menu

The File menu (Figure 3-8) allows users to open and save method files, view experiments,
print files, and set system and software options. Table 3-2 describes the menu commands
and their respective functions.

File
Hew
Open...
Save

Save As..

Ctrl+N
Ctrl=0
Ctrl+5

1 Ch\Users\,.\Untitled.dataset

Options...

Figure 3-8: File Menu

Table 3-2: File Menu Commands and Functions

Menu

Command

New

Function

Opens a new file after clearing out the existing experiment information
that may exist on the software screen from a previous run.

9 NOTE: This menu option performs the same action as click-
ing the New Experiment icon.

Open

Opens a previously saved experiment.

Save or File
> Save As

Saves an experiment data file.

Export to
csv

Saves the results table to a .csv file that can be opened in a spreadsheet
application.

Create
Report

Creates a report of the experiment in PDF file format.

BLItz User Guide



BLItz Pro Software User Interface page 19

Table 3-2: File Menu Commands and Functions (Continued)

Menu Function

Command

Options Defines the system options available. To view the BLItz system options:
1. On the main menu, click File > Options.

2. Onthe Options dialog box (see Figure 3-9), confirm the default set-
tings or enter new settings, and click OK.

Options =)
Data Options — Notification Sounds
Soeandge BB | W et
Shaker
Shakerspeed (ipm) 2200 B
[C] Atways open in simulation mode if not connected to an instrument
[ ok | [ cancel |
| J
Figure 3-9: Options Dialog Box
Data Specifies the number of decimal places (from two to nine)
Options—  for the computed data. The default setting is 4.
Significant
digits
Shaker— Shaker speed (rpm)—Sample platform orbital shaking
Shaker speed (rotations per minute). The default setting is 2200.
Speed (rpm)  The shaker can be set to speeds in the range of 1000-2600
rpm.
e NOTE: The default of 2200 rpm should be
used in all kinetics experiments. The default
speed also works well for the Quick Yes/No,
Create Standard Curve and Quantitate
Sample experiments. In these experiments,
to work with high concentration samples,
you may reduce the shake speed to lower
levels.
Notifica- When enabled (checked), plays sounds through computer
tion speakers at the end of the hydration process, the end of a
Sounds step, or at the end of a run. Click Reset Sounds to revert

back to the default sound settings.

BLItz User Guide
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Table 3-2: File Menu Commands and Functions (Continued)

Function

Click the Always open in simulation mode if not con-
nected to an instrument check box if you anticipate to
work offline.

Exit Closes the software after prompting you to save any changes.

Experiment Menu

The Experiment menu (Figure 3-10) displays the experiment modes available to run. Once
you launch the BLItz Pro software, you may begin your experiment using one of the experi-
ment modes available in the left pane (Figure 3-4: on page 16).

Table 3-3 describes the menu commands and their respective functions.

Experiment IInstrument Help

Welcome

® || Quick Yes/No
Create Standard Curve
Quantitate Sample
Basic Kinetics

Advanced Kinetics

Convert to Create Standard Curve

Convert to Quantitate Sample

Integration Settings...

Figure 3-10: Experiment Menu

Table 3-3: Experiment Menu Commands

Menu Command Function

Welcome Displays the Welcome page upon launching the BLItz Pro soft-
ware. Provides a high-level overview of the BLItz system and BLItz
Pro software capabilities.

Quick Yes/No Opens the Quick Yes/No mode for experimentation. Determines
the presence of an analyte with a simple dip and read. Can
include positive/negative control samples to compare the
unknown results.

Create Opens the Create Standard Curve mode for experimentation.

Standard Curve Runs multiple standard concentrations to create a standard
curve. For best results in quantitation, proteins used as standards
should be identical to unknown and should be measured in the
same sample milieu.
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Table 3-3: Experiment Menu Commands (Continued)

Menu Command Function

Quantitate Sample Opens the Quantitate Sample mode for experimentation. Quan-
titates unknown samples against a standard curve.

Basic Kinetics Opens the Basic Kinetics mode for experimentation. Generates
binding curves for proteins of known. Use this mode to run kinet-
ics experiments when the ligand is already bound to the biosen-
sor, either as supplied by Pall ForteBio, or through an offline
incubation of biosensor with ligand on the bench top.

Advanced Kinetics  Opens the Advanced Kinetics mode for experimentation.
Enables ligand loading, followed by the generation of binding
curves, and measures kinetic constants (k,, kg, Kp) for proteins of
known concentrations.

Convert to Create Switches the current mode to the Create Standard Curve mode.

Standard Curve Use if the data generated in a Quantitate Sample experiment
needs to be transferred to the Create Standard Curve mode for
treatment as standard samples.

Convert to Quanti-  Switches the current mode to the Quantitate Sample mode. Use if
tate Sample the data generated in a Create Standard Curve experiment must
be transferred to the Quantitate Sample mode for quantitation.

Integration Set- Only available for Quantitate Experiments. Optimizes the inte-

tings gration time at the start of each run. A short step is inserted at the
start of each run where you are prompted to dip the biosensor in
the tube to optimize the integration time to be used during the
run.

Instrument Menu

The Instrument menu (Figure 3-11) resets or stops the BLItz Pro system during an experi-
ment. Table 3-4 describes the menu commands and their respective functions.

Instrument
Reset

Figure 3-11: Instrument Menu

Table 3-4: Instrument Menu Commands

Menu Command Function

Reset Resets the system.

Stop! Stops the current experiment run.
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Security Menu

An additional Security menu (Figure 3-13) displays when running BLItz Pro CFR software.

Security I Help
View Audit Trail...
Change Praoject 3

Change Password...

Server Administration...

Lock Application...

Logoff...

Figure 3-12: Security Menu

Table 3-5: Security Menu Commands

Menu Command Function

View Audit Trail Displays a historical log of user, system and software
events recorded during user sessions.

Sign Document Allows you to electronically sign documents. Once a docu-
ment is signed, no further changes are allowed to the data
file. Up to two signatures are allowed per data file.

Remove Signature Allows you to remove the signatures assigned to the docu-
ments.

Change Project During an active session, allows you to switch to another
project.

Change Password Allows you to change the user password.

Server Administration When launching ForteBio GxP Server for the first time, you

will be prompted to create an Administrator user account
and to set the connection to clients. Please consult with
your IT administration, if applicable, for configuring the
BLItz Pro CFR for network use.

Lock Application Locks the BLItz Pro CFR software during a user session to
prevent another user from interrupting a session or experi-
ment. When the application is locked, any experiments
started will continue to run.

Logoff Ends a user session.
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Help Menu

The Help menu (Figure 3-13) displays the links to BLItz user guides, the BLItz Pro software
version, and license information. Table 3-6 describes the menu command and its respective
function.

Quickstart Guide F1
User Guide
ElItz Web Site

About BLitz

Figure 3-13: Help Menu

Table 3-6: Help Menu Commands

Menu Command Function

Quickstart Guide Opens the latest PDF of the BLItz System Quickstart Guide.

User Guide Opens the latest PDF of the BLItz System and BLItz Pro Soft-
ware User Guide.

BLItz Web Site Opens your browser to the BLItz web site
(http://www.blitzmenow.com).

About BLItz Displays the BLItz properties and license information.
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Icons

Table 3-7 list and defines the BLItz Pro software icons and status markers.

Table 3-7: BLitz Pro Software Icons

Icon Function

é BLItz Pro—Represents the BLItz Pro software.

Ready Ready—Indicates that the BLItz Pro software is ready to use.

A Drop Holder—Indicates that the drop holder is in the read position.

g Tube—Indicates that the tube position is in the read position.

i Hydrate Biosensor—A timer to use for the biosensor hydration step. Set

up the hydration time and click the Hydrate Biosensor icon to start. You
may stop the hydration timer by clicking the Stop icon. Otherwise, after
hydration, the timer runs down to zero (0) and the icon changes to Hydra-
tion Done. The window shakes until the Hydration Done icon is clicked.

P Stop—Stops the hydration or experiment.

Hydration Done—Displays when the hydration process is complete. Is
preceded by a ringtone to indicate completion. See the Table 3-2 on
page 18 about notification sounds. The window shakes until the Hydra-
tion Done icon is clicked.

New Experiment—Creates a new experiment, or clears your existing
experiment for a new experiment.

(@~

e NOTE: This menu option performs the same action as click-
ing the File > New command sequence.

@ Next—Guides you to the next step of the experiment run process.

Initial Baseline—Mandatory step type used in Advanced Kinetics experi-
ments.

k= Initial Baseline

Loading—Step type used in Advanced Kinetics experiments to load

'Lﬁ Loading . ]
ligand on biosensors.
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Table 3-7: BLItz Pro Software Icons (Continued)

Icon Function

Baseline—Step type used in Basic and Advanced Kinetics experiments for
the Baseline immediately preceding the Association step.

bk~ Baseline

9 NOTE: Baseline and Dissociation steps should be performed
in the tube.

Association—Step type used in Basic and Advanced Kinetics experi-
ments to monitor the binding of an analyte to a ligand on the biosensor.
Association should be monitored in tube for incubation times more than
five (5) minutes. Up to five (5) minutes of association can be performed in
the drop holder or tube.

¥ Assaciation

Dissociation—Step type used in Basic and Advanced Kinetics experi-
ments to monitor the dissociation of an analyte from a ligand. Dissocia-
tion should be monitored in the tube only.

L. Dissociation

UNINSTALLING THE BLITZ PRO SOFTWARE

To uninstall the BLItz Pro software:

1. From the Windows Start menu, click the & icon (or the button) and click All
Programs > ForteBio > Uninstall BLItz Pro.

You are prompted to confirm the request remove the BLItz Pro software and all of its
components.

2. Click Yes to confirm the removal of the BLItz Pro software and all of its contents.

3. Click OK to exit.
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BLITZ PRO CFR SOFTWARE

The BLItz Pro CFR software provides additional support for GMP and GLP laboratory users.
This version of the software includes features, such as user account management, audit
trails, and electronic signatures. Use of BLItz Pro CFR software requires the additional instal-
lation of the ForteBio GxP Server software module, version 8.0 or higher.

This chapter describes how to use the ForteBio GxP Server module and the additional fea-
tures enabled in the BLItz Pro CFR software.

NOTE: BLItz Pro CFR files may be opened in the non-CFR version of the soft-

e ware in a read-only session. Non-CFR files may be opened and re-saved in
BLItz Pro CFR software. The audit trail notes that the file was generated outside
the CFR software, and subsequent actions will be captured.

FORTEBIO GXP SERVER MODULE

Launching the ForteBio GxP Server for the First Time

When launching the ForteBio GxP server for the first time, you will be prompted to create
an Administrator user account and to set the connection to clients. Please consult with your
IT administration, if applicable, for configuring the BLItz Pro CFR for network use.

Should the BLItz Pro CFR and ForteBio GxP server reside only on the same computer, the
“Localhost” option may be checked, and a port number chosen that is not currently used by
another software application. If the ForteBio GxP server will be installed on a separate com-
puter from the BLItz Pro CFR software, the computers must be connected over a network.

Assigning Additional Users

To assign additional users:

1. Inthe Users tab of the software, right-click and select a new user.
2. Enter the new user information and click OK.

Figure 4-1 displays a blank New User dialog box for you to complete for the new user.
Figure 4-2 displays a completed version of the users created.
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New User — - — (=X

Login name:

Full name:
Information:
Password:
Confirm password:

Password reminder:

Group: [Supervisor i
Supervisors can review data and events

Privileges: [ Administration - administers the user database
Review - reviews changes and events
[ change - can change methods and configuration values
[Cplate - can change sample plate properties
[FIRun - can run experiments and analyses

Options: || Password does not expire [ oK ] [ Cancel

Figure 4-1: New User Configuration

NOTE: Login names must be unique, and duplicates will not be allowed by the

e ForteBio GxP Server. Additionally, you can assign permissions to the user
based either on a pre-set privileges based on user Group, or assign individual
sets of privileges to enable particular workflows.

e NOTE: The ForteBio GxP server is shared by the BLItz and Octet platforms. The
“Plate” privilege has no designated function with the BLItz system because it
does not accept samples in a microplate format.

:%| ForteBio GxP Se x

E Connection to dients:

http: /jwww. fortebio.com . _

. [T Localhost Port: 20002 = Apply & Test
Support UDP ping for discovery Default

Users |Groups I Projects I Constants I Evems|

Login Mame  Full Mame Group Privileges Password Age  Info

Administrator  Admin User Administrator  admin 00:00:00 Default administrator user
User 1 Supervisor Supervisor review 00:01:21

User 2 Lab Tech Supervisor run 00:01:03

User 3 Assay Developer  Supervisor change, run  00:00:47

Figure 4-2: Assigning Additional (New) Users
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Assigning Privileges by Group

Software permissions can be assigned to individual users based on the Group to that they
belong. In the Groups tab of the ForteBio GxP server, there are five pre-assigned Groups.
The name and specific privileges for each Group can be modified by double-clicking the
Group of interest. To create a new group or assign privileges by group, right-click in the dia-
log box to expose and select this option.

I |

<% ForteBio GxP Server Configuration - 8.0.0.1 P

Connection to dients:
hittp:/fwww. fortebio.com = _
[Locakhost Port: 20002 | %] | Apmly &Test
Support UDP ping for discovery Default

| Users | Groups |Projeds I Constants I Evems|

Mame Privileges Info

Administrator admin, review, change, plate  Administrators can add/deletefedit users and groups

Supervisor review Supervisors can review data and events
Developer change, plate, run Developers can create, run, save and export data
Lab User run Lab Users can only run experiments

Guest (none) Guests have no explict privileges

Figure 4-3: ForteBio GxP Server Groups Tab

Creating Projects for Sorting Events

For additional sorting of the audit trail of events, the ForteBio GxP server introduces a proj-
ects concept. Method files used in BLItz Pro can be associated with specific projects, and
the Events log filtered by project.

To create a new project, in the Projects tab, right-click to configure settings and create new
projects.

New Project )

Project name:

Information:

[ 0K ] [ Cancel

Figure 4-4: Creating a New Project
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Setting Constants for Advanced Options

The Constants tab contains global security settings that affect all users and enhance secu-
rity:

« PasswordTTL is the lifetime set for user passwords. The value entered is in days.

« PasswordMinLength sets the minimum number of characters required for a pass-
word. If set to 0, a password is not required to log in. This is not recommended.

- PasswordSecure affects the complexity of passwords. A value other than zero (0)
requires a minimum length of three characters and the inclusion of at least one
alphabetic, one numeric, and one punctuation character.

+ CredentialsTTL allows for offline use of the BLItz Pro CFR software in a networked
environment. The value entered sets the maximum amount of time BLItz Pro CFR can
be used in the absence of reconnecting to the ForteBio GxP server. Users are authen-
ticated locally until the connection to the ForteBio GxP server is restored, and
changes to the audit trail are integrated.

« UserldleMin logs a user out of the BLItz Pro CFR software after a specified amount of
time. The value is in minutes.

F ™
1%/ ForteBio GxP Server Configuration - 8.0.0.1 ==
Connection to dients:
e e [T Localhost Port: 20002 5 foplyfiest

Support UDP ping for discovery Default
| Users | Groups | Projects | Constants |Events

MName Value

PasswordTTL 180
PasswordMinLength 0
PasswordSecure 0
CredentialsTTL 3
UserIdleMin 15

Figure 4-5: Constants Tab—Advanced Options
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Viewing Events in the Audit Trail

The Events tab contains the global audit trail. The events can be sorted by user, project,
and machine (i.e. computer used) in the drop-down menus. The list can additionally be
ordered by clicking any of the column headers. For example, to sort events by user, click the
Login Name. The default method of sorting is by date/time.

Connection to dients:
http: {fwww. fortebio. com o
[T Localhost Port: 20002 5

Support UDP ping for discovery

Apply & Test
Default

| Users I Groups I Projects I Constants | Events |

User: |{@ny) | Project: [(any} v] Machine: [(any} v]

Date/Time

2012/12/10 14:21:37 Administrator
2012{12/10 14:20:38 Administrator
2012/12/10 14:19:09 Administrator
2012{12/10 14:17:04 Administrator
20121031 13:02:05 Administrator
20121031 12:59:49 Administrator
2012/12/11 21:10:42  Administrator
2012/12/10 14:17:55 Administrator

Login Mame  Project Machine Type Info

CAMP-TINC  User changed Testl
CAMP-TINC  User changed Testl
CAMP-TINC  User changed Testl
CAMP-TINC  User changed Testl
CAMP-TINC  User changed Testl
CAMP-TINC  User added Testl
CAMP-TINC Password changed Testl
CAMP-TINC Password changed Testl

2012/10/31 13:00:51
2013/04/04 10:10:59
2012/10/31 13:00:36
2012/10/31 13:01:40
2013/05/06 11:11:19
2013/05/06 09:58:43
2013/05/06 11:11:15
2013/05/06 09:58:42
2013/05/06 11:11:18

2013/04/29 10:09:07 Test User

Administrator
Administrator
Administrator
Administrator
Test User
Test User
Test User
Test User
Test User

CAMP-TINC  Sign document

CAMP-TINC
CAMP-TINC
CAMP-TINC
CAMP-TINC
CAMP-TINC
CAMP-TINC
CAMP-TINC
CAMP-TINC
CAMP-TINC

User deleted

User added

User added

Project added

Step correction modified
Fitting modified

Step correction modified
Fitting modified

Step correction modified

Test sign

Test1

test 1

Test1

Test

Start of dissodation Cr
Start of dissodation Cr
Start of dissodation Of
Start of dissodation Of
Start of assodation On

2013/05/06 09:58:42 Test User CAMP-TINC  Fittina modified Start of assodation On ™
4 | i | b

Figure 4-6: Viewing Events in the Audit Trail
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LAUNCHING THE BLITZ PRO CFR SOFTWARE FOR THE FIRST TIME

When launching the BLItz Pro CFR software for the first time, perform the following steps:
1. On your desktop, navigate to and click the BLItz Pro software icon.

2. When the Login dialog box displays, click ... (ellipsis) to select a Server location
(Figure 4-7).

Login

fortésio

A Division of Pall Life Sciences

Server: localhost: 20002 E]
User: Administrator -
Password:
Project: [(none} - ]

[ oK ] [ Cancel ]

Figure 4-7: Launching the BLItz Pro CFR Software for the First Time

3. Confirm that the Server location is correct.
a. Click Default to recall the default server settings of localhost and Port 2002.

Local host—If the local computer is to be used as the GxP Server module host, click
the Localhost check box. Change the Port number if necessary.

Remote host on same subnet—If the GxP Server module is hosted on the same
subnet, deselect the Localhost check box and click Find. A list of potential GxP
Server module addresses will be listed. Choose the location and click OK.

Remote host on another subnet—If the GxP Server module is hosted on a different
subnet, deselect the Localhost check box. Enter the IP address of the computer
hosting the GxP Server module.

b. When the Server module host location has been selected or entered, click OK to
save changes and exit the Authentication Server dialog box.

4. On the Login dialog box, from the User drop-down list, select a login name.

NOTE: To start an administrator session, select Administrator in the User
drop-down list.

5. Enter your password in the Password text box. (Click ? for a password reminder if
needed.)

6. Select a project from the Project drop-down list, if required.

7. Click OK.
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RESTRICTED PRIVILEGES

The main differences users of the software notice is the availability of fields in the BLItz Pro
CFR software based on assigned privileges. The general workflows enabled by the pre-set
privileges assigned to Groups are as follow:

« Users can modify descriptors in Run Settings for an experiment, but cannot alter the
run time and shaker settings. Once data has been acquired, changing sample
descriptors, such as Sample ID and Concentration, cannot be altered. Users can also
load standard curves for quantitation, but cannot save their own.

- Developers have all of the permissions of Users, but can modify the run time and
shaker settings for an experiment, as well as modify sample descriptors after the data
has been acquired. Developers can also save standard curves.

« Supervisors can open files and make changes to settings that affect only the dis-
play.
- Administrators have all of the previously mentioned privileges.

COMPLIANCE FEATURES

Software features to support compliance can be accessed by clicking the Security menu.

Security l Help
View Audit Trail...
Change Project »

Change Password...

Server Administration...

Lock Application...
Logoff...

Figure 4-8: Security Menu
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Viewing the Audit Trail

The Audit Trail displays a historical log of user, system and software events recorded during
user sessions. To view the Audit Trail (see example in Figure 4-9), click Security > View

Audit Trail.

) Audit Trail

= B S

Project: ’Antigen :Antibody screen hd

Machine:

JRICHARDS

7

Date/Time

2011/02/14 13:00:53
2011/02/14 13:18:01
2011/02/14 13:42:07
2011/02/14 13:42:45
2011/02/14 13:43:30
2011/02/14 13:44:09
2011/02/14 13:49:09
2011/02/14 13:49:14
2011/02/14 13:49:30
2011/02/14 13:49:34
2011/02/14 13:50:59
2011/02/14 13:54:47
2011/02/14 14:18:46

Project

Antigen:Antibody screen
Antigen:Antibody screen
Antigen:Antibody screen
Antigen:Antibody screen
Antigen:Antibody screen
Antigen:Antibody screen
Antigen:Antibody screen
Antigen:Antibody screen
Antigen:Antibody screen
Antigen:Antibody screen
Antigen:Antibody screen
Antigen:Antibody screen
Antigen:Antibody screen

Machine

JRICHARDS
JRICHARDS
JRICHARDS
JRICHARDS
JRICHARDS
JRICHARDS
JRICHARDS
JRICHARDS
JRICHARDS
JRICHARDS
JRICHARDS
JRICHARDS
JRICHARDS

Action

User login
User login
User logout
User login
User logout
User login
User login
User logout
User login
User logout
User login
User login
User login

Description

Figure 4-9: Audit Trail

Electronic Signatures

The BLItz Pro CFR software also adds support for electronic signatures. To sign a data file, on
the Security menu, select Sign Document or click the lock icon. A password is required to
authenticate the signing, and a prompt will follow to capture the meaning of the signature.

Add Electronic Signature PS

‘fou are about to electronically sign this document. Once signed, the document can no longer
be modified, regardless of permissions.

Reason for signing:

Data reviewed and approved.

Sign as:
User: User 3 (Assay Developer) Server: 127.0.0.1
Project: Machine: CAMP-TINC

[ 5o ][ coned

Figure 4-10: Electronically Signing a Document

Once a document is signed, no further changes are allowed to the data file. Up to two sig-
natures are allowed per data file.
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Changing Projects During a User Session
During an active session, users can switch to another project:
1. Click Security > Change Projects.

A list of projects assigned to your user account displays with the active project high-

lighted.
Security | Help
View Audit Trail...
(none)
Receptor: Ligand screen
Change Project *| © Antigen:Antibody screen
Change Password... Cell Culture screen
Server Administration...
Lock Application...
Logoff...

Figure 4-11: Changing Projects

2. Select the desired project from the list.

The selected project will now become the active project for the user session.

Changing the User Password

To change the user password:

1. Initiate a new user session with your existing password.

2. When the software launches, click Security > Change Password.

The Change Password dialog box displays.

Current password:

New password:

Confirm new password:

Password reminder:

Figure 4-12: Change Password Dialog Box

3. Enter the Current password for your user account. Click ? for a password reminder.
4. Enter the New Password and Password reminder (optional).

5. Click OK to save changes and exit.
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Locking the Application

The BLItz Pro CFR software can be locked during a user session to prevent another user
from interrupting a session or experiment. When the application is locked, any experiments
started will continue to run.

To lock the application:
1. Click Security > Lock Application.

The software is placed in locked mode immediately and the Application Locked dia-
log box displays (Figure 4-13).

Application Locked

I Fd

fortésio

| A Division of Pall Life Sciences
User: Administrator

Password:

[ Unlock. ] [ Logoff ]

Figure 4-13: Application Locked Dialog Box

2. The application remains locked until it is unlocked or the active user logs off.

+ Unlock—To resume the user session, enter your password and click Unlock.
« Logoff—To discontinue the user session, click Logoff.

Ending a User Session

To end a user session:

1. Click Security > Logoff.

2. Inthe displayed dialog box, click OK.
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Chapter 5: Working with Experiments

INTRODUCTION

The section provides a set of specific instructions based on the Starter kit included with
your BLItz system. We highly recommend to new users that you first perform the tests illus-
trated in this guide to familiarize yourselves with BLItz system operations before embarking
on your own experiments. The specific experiment instructions should help you in design-
ing and running your own experiments.

ACCESSING BLITZ EXPERIMENT MODES

To access the BLItz experiment modes:

1. Launch the BLItz Pro™ software: on the desktop, double-click the BLItz Pro d) icon.

The BLItz Pro Welcome page (Figure 5-1) displays with the Experiments listed in the
left pane.

the Experiment menu.

You can access any Experiment type by clicking the icons in the left pane, or by clicking

For a description of the Experiment menu commands and their respective functions
and experiment type definitions, see Table 3-3 on page 20.

Title Bar

-
—— & Untitled - BLitz Pro (CFR) 1.2.0.36

¢ File Instrument  Security  Help

Menu Bar

Experiment
Types —]

Status Bar —

% BLItz - Drop. Read. Done.

$ E

Welcome

N

Quick Yes/Mo Support

+ Call1-855-BLITZME

N

Create Standard Curve

*  Email blitzsupport@fortebio.com

Top Eight Things to Know About Using BLItz

Welcome to BLItz Pro™ Software. Always start with BLitz Pro software and follow on-screen instructions.

Setting up an experiment

™

Quantitate Sample

~

Basic Kinetics

~

Choose Experiment type
from menu in left pane of
BLitz Pro software, input
experiment info and click
NEXT.Then, follow the
prompts to load sample
and biosensor on the BLItz
system.

Placing a drop of sample in drop holder

— g,

Y

Pipeta 4 pL drop of sample
inside the dimple in the
drop holder. Check to make
sure that there are no air
bubbles in the liquid

Cleaning Drop Holder
Advanced Kinetics

N\

Atthe end of a run, wipe
the sample from the drop
holder with a Swab, or with
the corner of a folded lab
wipe. Rinse with buffer and
blot with lab wipe. Use

0.5N HCl instead of buffer for deep cleaning. Follow up
with buffer rinse te remove all HCl.

Hydration of Biosensors

Perform hydration on the
bench in the blue
bisensor tray for at least
ten minutes before use. Use
the same buffer as that in
your sample.

Mounting Biosensors

Push a hydrated biosensor
on to the mount and give a
final quarter-turn-upward
twist to ensure a snug fit
Do not let the biosensor to
dry. Keep the biosenser
hydrated until ready to use.

Placing and removing drop holder

The drop holder is
magnetic and easily snaps
into place. Replace drop
holder when damaged or
contaminated

Ready

[@ Project: (ne

Figure 5-1: BLItz Pro Software Welcome Page
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Defining Experiment Types

The BLItz Pro software’s Experiments menu lists the experiment types: ‘

e~

+ Quick Yes/No. Determines the presence of an analyte with a simple
dip and read. Can include positive/negative control samples to com-
pare to the unknown results.

Welcome

N

+ Create Standard Curve. Runs multiple standard concentrations to cre- quicctetle

ate a standard curve. For best results in quantitation, proteins used as
standards should be identical to unknown and should be measured in  create standard cure
the same sample matrix.

NN

+ Quantitate Sample. Quantitates unknown samples against a standard
curve.

Quantitate Sample

S

+ BasicKinetics. Generates binding curves for proteins of known con-
centrations and measures kinetic constants (k,, kg, Kp).

Basic Kinetics

~

- Advanced Kinetics. Enables ligand loading, followed by the genera-
tion of binding curves for proteins of known concentration, and mea-
sures kinetic constants (k,, kg, Kp)-

Advanced Kinetics

BEFORE YOU START YOUR EXPERIMENT

+ Allow all required reagents to warm to room temperature before running your
experiments on the BLItz system.

« Handle biosensors carefully. Do not touch the tip of the biosensor or bring into con-
tact with surfaces.

« Hydrate only the biosensors needed for an experiment. Store unused biosensors dry
on the benchtop in the biosensor tray.

« Do not leave a hydrated biosensor to dry. Keep it dipped in buffer until ready for use.

. Store hydrated biosensors for up to 48 hours in a refrigerator (2-8 °C) and warm to
room temperature before re-use.

+ Dispose used biosensors in a sharps container.

+ Use 4 uL of sample in the drop holder. Use 250 uL of sample or buffer in the tube. (A
tube is used in Basic Kinetics and Advanced Kinetics experiments.)

+ Ensure that there are no bubbles in the sample. Bubbles may cause erratic signals.

« Between experiment steps, when lifting the BLItz system cover, lift all the way up to
ensure proper electronic communication with the BLItz Pro software.
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Navigating Through the BLItz System

The BLItz Pro software’s NEXT button is an important tool in communicating with the BLItz
system. After entering Experiment Settings and Run Settings, click the NEXT button to start
an experiment. The software starts communicating with the BLItz system to guide you
through the process of adding samples and mounting biosensors on the BLItz system to
complete your experiment.

Enter your Cxperiment Settings.

Experiment Mame:

Mew Experiment
Desenphon

Frlur your Hun Setlmgs

Sample 10

Biozensor type: Pralen A - Run ime (3). 20 = ia'
Concentration: pgiml - Shaker Ensble - Run |b

Figure 5-2: Entering Experiment and Run Settings

NOTE: Clicking NEXT displays User Action Required messages that guide
e you through the steps of your experiment. It is imperative to read the action
messages and follow the instructions.

User Action Required 0

Open the cover.

Mext

(simulation)

Hydrating Biosensors

IMPORTANT: Biosensors must be hydrated before use in any experiment.
o * Hydrate only those sensors to be used in an experiment.

* Hydrate just before running an experiment.

* Hydrate for at least 10 minutes.

* Do not leave the biosensors to dry on the biosensor mount.
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Pall ForteBio's biosensors should be dipped in buffer to hydrate the bio-layer at the tip and
prepare it for use in a run. Hydration is performed on the bench top in the blue tray pro-
vided. A 96-well microplate is required for the hydration.

In the BLItz Pro software, each experiment mode reminds you to perform this hydration
step. The timer included in the software may be used to time your hydration. Alternatively,
you may use a lab stop watch to time your hydration. You do not need to hydrate exactly for
10 minutes; a minimum of 10 minutes is sufficient.

Use the following procedure to set up biosensor hydration:

1. Ensure that all reagents to be used on the BLItz system are warmed to room tempera-
ture.

2. Add 200 pL of sample diluent or buffer only in wells of a 96-well microplate correspond-
ing to the biosensors that will be used in the experiment; for example, if using biosen-
sors A1 to A4 from the biosensor tray, add buffer only to wells A1 to A4 in the 96-well
microplate.

3. Remove the clear lid of the Protein A biosensor tray.

4. Lift the green biosensor rack carefully out of the blue biosensor tray holder
(Figure 5-3)—avoiding touching of the biosensor tips on any solid surface.

Figure 5-3: Biosensor Tray

NOTE: Use the black hydration microplate provided in the demo kit, in place of
e the clear microplate shown in Figure 5-3.

5. Place the hydration microplate inside the blue biosensor tray holder.

6. Carefully lower the green biosensor rack on top of the hydration microplate in the bio-
sensor tray holder to begin hydrating the biosensors.

7. Select a hydration time of 10 minutes (the default) or more, and click the Hydrate Bio-
sensor icon .=I-_-. (Figure 5-4).

Have you hydrated your biosensor?

Hydrate hiosensors prior to use for a minimurm of 10 minutes. Hydration time (min): |10 E -:l:-

Hydrate Biosensar

Figure 5-4: Hydrate Biosensors
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IMPORTANT: Prior to any experiment performed on the BLItz system, the bio-

o sensors must be hydrated for a minimum of 10 minutes to ensure active pro-
tein on the biosensor tip. Biosensors should be hydrated in a solution buffer
that is as similar to the sample matrix as possible.

NOTE: The hydration timer in the BLItz Pro software may be used to time the
@ biosensor hydration process. Users may also use other lab stop watch meth-
ods to monitor the hydration time.

The Hydrate Biosensors icon changes, indicating that the hydration process begins.
The Hydration time (min) field timer counts down the 10 minutes. You can click the
Stop Hydration icon 0 at any time to stop the hydration process (Figure 5-5).

Hydration time (min):

Femaining: 09:56 Stop Hydration

Figure 5-5: Stop Hydration Process

After hydration, the timer runs down to zero (0) and the icon changes to Hydration
Done (Figure 5-6). The window shakes until the Hydration Done icon is clicked.

Have you hydrated your biosensor?

Hydrate hiosensors prior to use for a minimurm of 10 minutes. Hydration time (min): I:I \"y
Hydration Dane

Figure 5-6: Hydration Done

NOTE: After hydrating, leaving a biosensor on the biosensor mount or in air to
dry will affect performance of the biosensor. If you do not plan to perform an
experiment immediately, leave the biosensor tip to hydrate.

8. Access any Experiment type by clicking the icons in the left pane, or by clicking the
Experiment menu (Figure 3-10: on page 20).
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RUNNING A QUICK YES/NO EXPERIMENT

When using the Starter kit to perform a Quick Yes/No experiment, perform the following
steps for human IgG samples binding Protein A biosensors.

To develop a Quick Yes/No experiment for your samples on the BLItz system, consider
these guidelines:

- Test a negative control and positive control sample along with your unknown.

« Use an appropriate biosensor type from Pall ForteBio’s list of off-the-shelf biosensors.
If one is not readily available, you may prepare a custom biosensor by loading your
ligand on any one of the biosensors available.

+ Use the drop holder for all Quick Yes/No measurements. Use 4 pL of sample diluent.

« Start with the default Run time value of 120 seconds to test your positive and nega-
tive controls. You may then optimize the Run time as needed. Typically, longer run
times allow more binding of analyte to the biosensor, thus providing greater signal.

+ Keep the Shaker in Enable mode to allow good mixing of sample. You can tweak the
shaker rate via File >Options menu to a value between 1000 and 2600 rpm to suit
your needs. Typically, increasing shaker rate leads to faster binding rates.

« Always input experiment info first and click Next. Follow the on-screen prompts to
load sample and biosensor on the BLItz system.

The following experiment is an example of a Quick Yes/No experiment, where higG is the
analyte you will use to prepare three (3) samples: positive control (1000 pg/mL), “unknown”
(100 pg/mL), and negative control (sample diluent). The 100 ug/mL hlgG sample will be
considered a mock “unknown” sample to show how BLItz can evaluate the presence of your
protein in a sample. The negative control (sample diluent) will also be used as the sample
blank (reference).

Everything you need is in the demo kit:
 Protein A biosensors

+ hlgG stock (10 mg/mL)

« sample diluent

«  96-well, black flat-bottom microplate
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To run a Quick Yes/No experiment:

1. Click the Quick Yes/No icon ﬁ to display the Quick Yes/No experiment mode
(Figure 5-7). Quick Yeslo

Quick Yes/No

Have you hydrated your biosensor?
Hydrate biosensors prior to use for a minimum of 10 minutes. Hydration time (min): 10 =

Hydrate Biosensaor

Enter your Experiment Settings E
Experiment Name:

New Experiment

Description:

Enter your Run Settings

Sample ID:

Biosensortype: Pratein A - Run time (s): 120 =

Concentration: Shaker: Bun 1

Figure 5-7: Quick Yes/No Experiment

Preparation

2. Ensure that all reagents to be used on the BLItz system are warmed to room tempera-
ture.

3. Hydrate three (3) biosensors, as described in “Hydrating Biosensors” on page 42.
4. Prepare the hlgG test samples as follows:

« 1000 pg/mL hlgG (positive control): 20 pL of stock higG + 180 pL of sample dilu-
ent

+ 100 pg/mL hlgG (unknown sample): 10 uL of 1000 pg/ml solution + 90 uL of
sample diluent

NOTE: higG samples should be run in this order:
e Run 1: sample blank (negative control)

Run 2: 100 ug/mL (unknown)

Run 3: 1000 ug/mL (positive control)
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Experiment

5. Input Run Settings for Negative Control, as shown in Figure 5-8.

Enter your Experiment Settings

Experiment Mame: Quick Yes/Mo Demo

New Experiment

Description: Check for presence of human IgG in sample using Protein A biosensors

Enter your Run Settings

Sample ID: Negative Control

Biosensortype: Protein A - Run time (s): 30 =

Concentration: 0 Shaker: Run 1

Figure 5-8: Entering Run Settings for Negative Control

a. Enter a Run time of 30 seconds.

b. Click @ |

6. Follow the on-screen instructions (Figure 5-9).

User Action Required User Action Required

Openthe cover. Pipette your sample onto the drop holder.
Load a biosensor and close the cover.

Figure 5-9: User Action Required—Experiment Operations
7. Add 4 pL of the sample diluent for the first run into the drop holder (Figure 5-10).
g _“ p—
‘ ‘:
Figure 5-10: Adding 4 uL of Sample into Drop Holder

8. Load the Protein A biosensor on to the biosensor mount; give it a final quarter-turn
upward twist to ensure a snug fit (Figure 5-11).

Figure 5-11: Mounting a Biosensor
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9. Move the slider to the right to move the drop holder to the read position (Figure 5-12).

Figure 5-12: Moving Drop Holder to Read Position

10. Close the BLItz system cover to start data acquisition each time the BLItz Pro software
prompts you (Figure 5-13).

Figure 5-13: Closing the BLItz System Cover

Data is collected in real-time on screen. The sensorgram (Figure 5-14) displays the
results for Negative Control.

Binding (nm})

0

1} 5 10 15 20 25 30 5 40 45 50 55

B0
Time (sec)

MNegative Control

Figure 5-14: Data Collected in Real-Time—Binding Signal Measured in nanometers (nm) as a Function of
Time (seconds)

After the run, a Save As dialog box displays and prompts you to save the experiment
file (Figure 5-15).
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i sevens - - |

-
@U'l » BlLitz Demo » Demo Results w {49 Wl Search Demo Results )’-Jl
-

Organize » MNew folder = - [7)

{ Favorites

B Desktop =
& Downloads

. Recent Places

Bl Desktop
w4 Libraries
= Documents
o' Music
=/ Pictures
a Videos Sl

File name: Untitled.dataset i

Save as type: | BLitz Files (".dataset) |

—_
= Hide Folders [ s | Cancel

Figure 5-15: Saving Dataset File

11. Enter a file name and Save the dataset.

12. Lift the cover, discard the used biosensor, wipe the drop holder with a swab or Kimwipe
(Figure 5-16), and rinse 3X with sample diluent—wiping each time with a swab or Kim-
wipe.

The best way to rinse 3X with sample diluent is to take, at least, 20 uL of buffer
e in a pipet and add small aliquots into the drop holder followed by blotting
with a Kimwipe.

-
e
Figure 5-16: Wiping the Drop Holder with a Kimwipe

13. Perform subsequent sample runs by repeating steps 4 to 11 for each sample:
»  Run 2:100 pg/mL (unknown)
+ Run 3: 1000 pug/mL (positive control)

Data

14. Inspect the Run data.

The sensorgram (Figure 5-17) displays the results after all runs. The unknown sample
displays binding signal, indicating the presence of human IgG.
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Binding (nm}

o = m

] 5 10 15 20 2 a0 35 40 45 50 £5 B0
Time (sec)

Megative Control Unknown Positive Control

Figure 5-17: Inspecting the Run Data

15. Check the Run List table for the Binding Rate value for the unknown sample.

A higher value than that of the Negative Control should mean that protein is present in
the unknown sample (Figure 5-18).

Run List Report point (): |0 S Acld Rermowve All

Index| Show| Anakze Ref. Sample D Conc. (Hgfml)| Binding rate (nmys)| Buntime (g) Shaker speed (rpm)| Integration (ms)| Temperature
= = v MNegative Control 0 30 2200 1.3 345
4 4 ™ Unknown 05029 3o 2200 13 347

3 4 4 I~ Positive Contral 1000 3393 30 2200 13 34.7

I Exportto CSV .. ” Create Repaort... ]

Figure 5-18: Binding Rate Values in the Run List Table

Table 5-1 lists and defines the binding rate values in the Run List table.

Table 5-1: Binding Rate Values in the Run List Table

Parameter Description

Report point (s) Specifies a time point at which to report signal for all samples in
the graph.
« Add—Adds a report point to the table.

«  Remove All—Removes all the report points from the
table.

Index Numbered order of the curves processed. The index is useful to
sort back to the original order.

Show Controls whether the curve is displayed in the Run Data win-
dow.
Analyze Allows you to analyze the results. If not checked, this box

excludes the sample from further analysis.
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Table 5-1: Binding Rate Values in the Run List Table (Continued)

Parameter Description

Ref. Designates a sample for reference subtraction. If a single sample
is chosen, that will be subtracted from all other sample curves. If
multiple samples are chosen as reference, the average will be
subtracted from all other sample curves.

Sample ID The sample ID entered during experiment setup.

Conc. (pg/ml)

The molar concentration of the sample used in the association
step. The molar concentration is entered by the user or com-
puted by the molarity calculator during experiment setup.

Binding rate (nm/s)

The rate of sample binding to the biosensor computed by the
BLItz Pro software using the binding rate equation specified.

Run time (s) The duration of data analysis seconds.

Shaker speed (rpm) The sample platform orbital shaking speed (rotations per min-
ute). This value is set in File > Options.

Integration Reports the time intervals the spectrometer was exposed to

light in acquiring the data.

Biosensor Type

The biosensor chemistry utilized in the experiment. By default,
Protein A is used.

Information Information about the biosensor that was entered in the BLItz
system.

Status Indicates if a run is interrupted. For example, if a user stops a
run, the status is shown as “Terminated by User”.

Export to CSV Exports the data in the graph to .csv files, one for each sample.

Create Report

Creates a report of the experiment in a PDF file format.

Result

The “unknown” sample, which we know is a 100 ug/mL hlgG solution, displayed a binding
signal that indicates the presence of protein. In just a few minutes, you have successfully
tested a sample for presence of protein. Bravo!
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CREATING A STANDARD CURVE

When using the starter kit to perform a Create Standard Curve experiment, follow the
instructions provided below for human IgG samples binding Protein A biosensors.

To create a standard curve for your samples on the BLItz system, consider these guidelines:

« Use standards that are representative of the analyte/unknown in your Quantitate
Sample experiment.

+ Use a sample milieu that is representative of that in which the analyte/unknown will
be present in your Quantitate Sample experiment.

- Start with a broad concentration range of standard samples that will cover the ana-
lyte/unknown samples that you wish to quantitate.

«  When optimizing experiment conditions, use fewer standard samples distributed
over the concentration range. After optimizing experiment conditions, populate
more standard concentrations to maximize reliability of the standard curve.

+ Run standards from low to high concentrations to minimize interferences from carry-
over between samples. Cleaning the drop holder according to recommendations
should typically prevent such carryover.

« Usean appropriate biosensor type from Pall ForteBio's list of off-the-shelf biosensors.
If one is not readily available, you may prepare a custom biosensor by loading your
ligand on any one of the biosensors available.

« Use the drop holder for all Create Standard Curve runs. Use 4 pL of standard samples.

« Start with the default Run time value of 120 seconds. You may then optimize the Run
time as needed. Typically, longer run times allow more binding of analyte to the bio-
sensor, thus providing greater signal.

+ Keep the Shaker in Enable mode to allow good mixing of sample. You may tweak
shaker rate in File > Options to a value between 1000 and 2600 rpm to suit your
needs. Typically, increasing shaker rate leads to faster binding rates.

« Always input experiment info first and click Next. Follow the on-screen prompts to
load sample and biosensor on the BLItz system.

« Tofit a curve to the data, choose from the available options. When in doubt about
which curve fit is best, try all three options.

The purpose of this experiment is for using samples of known concentration to determine
the signal the system shows for each concentration.

This experiment should display a signal vs. concentration graph, which is the standard
graph. This is essential for using with the Quantitate Sample experiment. When you per-
form a Quantitate Sample experiment, you should have already performed the standard
curve experiment. If you do not do the Creating a Standard Curve experiment first, the sys-
tem will generate some data, but you will not know the details of the data, which is neces-
sary to use for the Quantitate Sample experiment. In this way, you can make assumptions
from the concentration provided.
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In this example Standard Curve experiment, higG is the analyte you will use to prepare
four (4) standards ranging from 15.6-1000 ug/mL. With sample diluent as the reference,
there will be a total of five (5) samples measured on the BLItz system.

NOTE: A standard curve should be created with protein or antibody identical
9 to, and in the simple matrix, as the unknown samples that will be quantitated.

Everything you need is in the demo kit:

- Protein A biosensors

+ hlgG stock (10 mg/mL)

« sample diluent

«  96-well, black flat-bottom microplate

To run a Create a Standard Curve experiment:

1. Click the Create Standard Curve icon Z to display the Create Standard
Curve mode (Figure 5-19). Create Standard Curve

Create Standard Curve
Have you hydrated your biosensor?
Hydrate biosensors prior to use for a minimum of 10 minutes. Hydration time (min): 10 =
Hydrate Biosensaor

Enter your Experiment Settings

Experiment Name: _
New Experiment

Description:

Enter your Run Settings

Sample ID:
Biosensortype: Pratein A - Run time (s): 120 =
Concentration: ug/ml = Shaker: Bun 1

Figure 5-19: Create Standard Curve

Preparation

2. Ensure that all reagents to be used on the BLItz system are warmed to room tempera-
ture.

3. Hydrate five (5) biosensors, as described in “Defining Experiment Types” on page 41.
4. Prepare the hlgG test samples as follows:

« 1000 pg/mL higG: 20 pL of stock hlgG + 180 uL of sample diluent. Label this as
“Stock A’

+ Using Stock A, perform the following dilutions:
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« Step 1— 4-fold dilution: 10 uL Stock A + 30 L sample diluent for a [higG] =

40 pL of 250 pg/mL

« Step 2—4-fold dilution: 10 uL 250 pg/mL + 30 pL sample diluent for a [higG] =

40 pL of 62.5 pg/mL

+ Step 3—4-fold dilution: 10 pL 62.5 pg/mL + 30 pL sample diluent for a

[hlgG] = 40 pL of 15.6 pg/mL

NOTE: higG samples should be run in this order:
e Run 1: 0 ug/mL (Reference)

Run 2: 15.6 ug/mL

Run 3:62.5 ug/mL

Run 4: 250 ug/mL

Run 5: 1000 ug/mL (Stock A)

Experiment

5. Input Run Settings per Figure 5-20 and click @ ‘

Enter your Experiment Settings
Experiment Mame: Create Standard Curve Demo

Description: Standard Curve for human IgG samples using Protein A biosensors

Enter your Run Settings

Sample ID: Reference

Biosensortype: Protein A - Run time (s): 30| =
Concentration: 1] pgfml - Shaker:

Figure 5-20: Entering Run Settings

6. Follow the on-screen instructions (Figure 5-21).

Open the cover. Pipette your sample onto the drop holder.
Load a biosensor and close the cover.

User Action Required User Action Required

Figure 5-21: User Action Required—Experiment Operations

4]

New Experiment

Run 1

7. Add 4 pL of the sample diluent for the first run into the drop holder (Figure 5-22).
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4"

Figure 5-22: Adding 4 uL of Sample Diluent into Drop Holder

8. Load the Protein A biosensor on to the biosensor mount; give it a final quarter-turn
upward twist to ensure a snug fit (Figure 5-23).

Figure 5-23: Mounting a Biosensor

9. Move the slider to the right to move the drop holder to the read position (Figure 5-24).

'...

[

-

Figure 5-24: Moving Drop Holder to the Read Position

10. Close the BLItz system cover to start data acquisition each time the BLItz Pro software
prompts you (Figure 5-25).

Figure 5-25: Closing the BLItz System Cover

Data is collected in real-time on screen (Figure 5-26). The sensorgram shows the results
after the first run.
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Run Data

0.4

0.2

Binding (nm}
o

02

0.4

0 5 10 15 20 25 30 35 40 45 50 55 B0
Time (zec)

Reference

Figure 5-26: Data for Run 1 Collected in Real-Time

After the run, a Save As dialog box displays and prompts you to save the experiment
file (Figure 5-27).

(77 — =)

_'_“. e, P a
@U'.l » BlitzDemo b Demo Resuits =ty | Setirch Demo Results

Organize » MNew folder = - [7)

= Name Date modifiec e
e Fviites Nam Date modified Ty

B Desktop B No items mat
& Downloads
. Recent Places

Bl Desktop
w4 Libraries
= Documents
o' Music
=/ Pictures
a Videos Sl i "

File name: Untitled.dataset i

Save as type: | BLitz Files (".dataset) |

—_
= Hide Folders [ s | Cancel

Figure 5-27: Saving Dataset File

11. Enter a file name and Save the dataset.

12. Lift the cover, discard the used biosensor, wipe the drop holder with a swab or Kimwipe
(Figure 5-28), and rinse 3X with sample diluent—wiping each time with a swab or Kim-
wipe.

‘ \

i
P _

Figure 5-28: Wiping the Drop Holder with a Kimwipe
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13. Perform subsequent sample runs as follows, repeating steps 4 to 12 for each sample:
+ Run2:15.6 ug/mL
+ Run3:62.5 pg/mL
+ Run 4:250 pg/mL
+  Run 5: 1000 pg/mL

Data
14. Inspect the Run data. The sensorgram (Figure 5-29) displays the results after five (5)
runs.

Run Data

a

4
g
<3
P
@

1

a

n] a 10 15 20 ) 30 35 40 45 a0 55 60
Time (sec)
Reference 158.6ug/mL B2.5ug/mL 250ug/mL 1000ug/mbL

Figure 5-29: Inspecting the Run Data

15. Click Save to save your experiment.

[RiTTn [Le Feportpoint(s: (0 *|| Add || Remaove Al

Conc. (hofml)| Binding rate (nmy's)) Run time (s)) Shaker speed (rpm)| Integration (ms)| Temperature

Index| Show| Anakze Ref Sample D

v v v MNegative Contral 0 30 2200 13 345

4 4 I~ Unknown 05029 30 2200 13 34.7

3 4 4 ™ Positive Contral 1000 3393 3o 2200 13 347
I Exportto CEV.. ” Create Report.. ]

Figure 5-30: Binding Rate Data in Run List Table
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Table 5-2 lists and defines the binding rate values in the Run List table.

Table 5-2: Binding Rate Values in the Run List Table

Parameter Description

Report point (s)

Specifies a time point at which to report signal for all samples in
the graph.
« Add—Adds a report point to the table.

+  Remove All—Removes all the report points from the

table.

Index Numbered order of the curves processed. The index is useful to
sort back to the original order.

Show Controls whether the curve is displayed in the Run Data window.

Analyze Allows you to analyze the results. If not checked, this box
excludes the sample from further analysis.

Ref. Designates a sample for reference subtraction. If a single sample
is chosen, that will be subtracted from all other sample curves. If
multiple samples are chosen as reference, the average will be
subtracted from all other sample curves.

Sample ID The sample ID entered during experiment setup.

Conc. (pg/ml)

The molar concentration of the sample used in the association
step. The molar concentration is entered by the user or com-
puted by the molarity calculator during experiment setup.

Binding rate (nm/s)

The rate of sample binding to the biosensor computed by the
BLItz Pro software using the binding rate equation specified.

Run time (s) The duration of data analysis seconds.

Shaker speed (rpm) The sample platform orbital shaking speed (rotations per min-
ute). This value is set in File > Options.

Integration Reports the time intervals the spectrometer was exposed to light

in acquiring the data.

Biosensor Type

The biosensor chemistry utilized in the experiment. By default,
Protein A is used.

Information Information about the biosensor that was entered in the system.

Status Indicates if a run is interrupted. For example, if a user stops a run,
the status is shown as “Terminated by User”.

Export to CSV Exports the data in the graph to .csv files, one for each sample.

Create Report

Creates a report of the experiment in a PDF file format.
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16. Click Save Standard Curve (Figure 5-31) to save the standard curve, rather than the
experiment file itself

Standard Curve Linear pointto point RSeS| Sawve Standard Curve..

EE 0

g25
14

220
=1
=

m 1.5

1.0

05

0

0 100 200 300 400 500 B00 700 800 300 1000 1100 1200
Concentration (pg/ml)
# | Standards Fitted Curve

Figure 5-31: Save Standard Curve

The drop-down menu provides curve fit options of:
+ (a) Linear point-to-point

« (b) Linear

+ (¢) 5-PL unweighted

Other general notes include:

. R2and Chi? values report goodness of fit.

« Standard curve equation and parameters (slope, y-intercept) are shown depend-
ing on the curve fit selected.
+ Save Standard Curve saves the standard curve as a fscfile.
Result

Your standard curve has been generated. You are now ready to perform quantitation exper-
iments. The 4-point standard curve that you ran just now is meant to serve as a demonstra-
tion of the standard curve experiment. If you create a standard curve for your samples, it is
important to have standards that cover the entire dynamic concentration range of interest
and populate enough data points in frequent intervals. Typically, a 2X or 3X dilution series is
recommended.
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RUNNING A QUANTITATE SAMPLE EXPERIMENT

When using the starter kit to perform a Quantitate Sample experiment, follow the instruc-
tions provided below for human IgG samples binding Protein A biosensors.

To measure concentration of proteins in your samples on the BLItz system, consider these
guidelines:

+ Create a standard curve that is representative of your unknown samples first before
testing your unknowns. You may choose to perform the standard curve experiments
after the Quantitate Sample experiments, but you will not be able to obtain concen-
trations of your unknowns until the standard curve is available.

+ Ensure that the sample milieu in the unknowns and the standards are the same.

+ Use the same experiment parameters such as Run time and Shaker speed for the
Quantitate Sample experiment as that used in the creating the standard curve.

« Use an appropriate biosensor type from Pall ForteBio’s list of off-the-shelf biosensors.
If one is not readily available, you may prepare a custom biosensor by loading your
ligand on any one of the biosensors available.

« Use the drop holder for all Quantitate Sample measurements. Use 4 pL of sample.

« Always input experiment info first and click Next. Follow the on-screen prompts to
load sample and biosensor on the BLItz system.

This mode allows you to quantitate unknown samples against a standard curve. This exper-
iment assumes that you have already created a standard curve (see “Creating a Standard
Curve” on page 52).

In this sample mode, you will prepare two (2) samples of hlgG of known concentrations,
and use the BLItz system to calculate their concentrations and confirm that the system reli-
ably measures protein concentrations.

Everything you need is in the demo kit:
 Protein A biosensors

+ hlgG stock (10 mg/mL)

« sample diluent

«  96-well, black flat-bottom microplate
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To run a Quantitate Sample experiment:

1. Click the Quantitate Sample icon E to display the Quantitate Sample mode
(Flgure 5-32), Quantitate Sample

Quantitate Sample

Have you hydrated your biosensor?
Hydrate biosensors prior to use for a minimum of 10 minutes. Hydration time (min): 10 =

Hydrate Biosensaor

Enter your Experiment Settings

Experiment Name: _
New Experiment

Description:

Enter your Run Settings

Sample ID:
Biosensortype: Pratein A - Run time (s): 120 =
Concentration units: |ug/ml = Shaker: Bun 1

Figure 5-32: Quantitate Sample

Preparation

2. Ensure that all reagents to be used on the BLItz system are warmed to room tempera-
ture.

3. Hydrate two (2) biosensors, as described in “Defining Experiment Types” on page 41.
4. Prepare hlgG “unknowns” as follows:

Using the Stock A (1000 pg/mL) that you created to perform the standard curve experi-
ment, perform the following dilutions:

+  5-fold dilution: 8 pL Stock A + 32 pL sample diluent for a [higG] = 200 pg/mL

+ 4-fold dilution: 10 pL 200 pg/mL + 30 pL sample diluent for a [hlgG] = 50 ug/mL

NOTE: higG samples should be run in this order:
Run 1: 50 ug/mL
Run 2:200 ug/mL

Quantitate Samples

5. Input Run Settings per Figure 5-33 and click @ ‘

BLItz User Guide



page 62 Chapter 5: Working with Experiments

Quantitate Sample

Have you hydrated your biosensor?

Hydrate biosensors prior to use for a minimum of 10 minutes. Hydration time (min): 10 =
Hydrate Biosensaor

Enter your Experiment Settings

Experiment Mame: Quantitate Sample Demo i

New Experiment

Description: Quantitation of mock "unknown" human IgG samples

Figure 5-33: Entering Run Settings

6. Follow the on-screen instructions (Figure 5-34).

User Action Required User Action Required

Openthe cover. Pipette your sample onto the drop holder.
Load a biosensor and close the cover.

Figure 5-34: User Action Required—Experiment Operation

7. Add 4 pL of the sample diluent for the first run into the drop holder (Figure 5-35).
. _“ -

Figure 5-35: Adding 4 uL of Sample Diluent into Drop Holder

8. Load the Protein A biosensor on to the biosensor mount; give it a final quarter-turn
upward twist to ensure a snug fit (Figure 5-36).

Figure 5-36: Mounting a Biosensor

9. Move the slider to the right to move the drop holder to the read position (Figure 5-37).
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Figure 5-37: Moving Slider to Bring Drop Holder or Tube to the Read Position

10. Close the BLItz system cover to start data acquisition each time the BLItz Pro software
prompts you (Figure 5-38).

Figure 5-38: Closing the BLItz System Cover

Data is collected in real-time on screen. The sensorgram (Figure 5-39) displays the
results after the first run.

Run Data

0 5 10 15 20 23 30 3 40 45 50

55 B0
Time (sec)

Unknowin1

Figure 5-39: Data Collected in Real-Time for Run 1

After the run, a Save As dialog box displays and prompts you to save the experiment
file (Figure 5-40).
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(77 — =)

Y = = = |
@U'l » BlLitz Demo » Demo Results w {49 Wl Search Demo Results Fe
-

Organize » MNew folder = - [7)

' Favorites
B Desktop = Mo items mat
& Downloads
. Recent Places

Bl Desktop
w4 Libraries
= Documents
o' Music
=/ Pictures
a Videos Sl

File name: Untitled.dataset i

Save as type: | BLitz Files (".dataset) |

-
= Hide Folders [ s | Cancel

Figure 5-40: Saving Dataset File

11. Enter a filename and Save the dataset.

12. Lift the cover, discard the used biosensor, wipe the drop holder with a swab or Kimwipe
(Figure 5-41), and rinse 3X with sample diluent—wiping each time with a swab or Kim-
wipe.

The best way to rinse 3X with sample diluent is to take, at least, 20 uL of buffer
e in a pipet and add small aliquots into the drop holder followed by blotting
with a Kimwipe.

‘ \
-
-

Figure 5-41: Wiping the Drop Holder with a Kimwipe

13. Perform subsequent “unknown” runs:

Run 2: 200 pg/mL

Select Standard Curve

14. Click the Load Standards button on the Standard Curve graph (Figure 5-42) and select
your standard curve (.fsc file) to load.
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NOTE: You must load the standard curve generated using the protocol
described in this guide.

Standard Curve

Load Standards... H Sawve Standards.. H Clear ]

45

Binding Rate (nm/s)
=2 = = [ s iy
m 5 m B m B

o

0 100 200 300 400 500 600 700 800 900 1000 1100 1200

Concentration {pg/ml)
# | Standards | # | Unknowns

Fitted Curve
1

Figure 5-42: Loading Standard Curve

« The drop-down menu provides curve fit options of:

+ (a) Linear point-to-point:
+ (b)Linear
+  (c) 5-PL unweighted

Other general notes:
. R?and Chi? values report goodness of fit.

» Standard curve equation and parameters (slope, y-intercept) are shown depending
on the curve fit selected.

» Load Standards loads an existing standard curve as a .fsc file.
+ Save Standards saves the standard curve as a fsc file.

+ Clear clears the loaded standard curve from the graph.

Data

15. Click Save to save your experiment.

16. Inspect the interpolated concentrations. Unknown1 should be about 50 pg/mL and
Unknown2 should be about 200 pg/mL.

Figure 5-43 displays the interpolated unknown concentrations.
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Reportpoint(s): 0 = Remove All

ze| Ref| Sample ID| Conc. (ug/ml)| Binding rate (nm/s), Run time (s)| Shaker speed (rpm)| Biosensor Type| Information
" Unknownl 554 0.2374 30 2200 Protein A
™ Unknown2 2205 08324 30 2200 Protein A

Figure 5-43: Interpolated Unknown Concentrations in Table

Table 5-3 lists and defines the binding rate values in the Run List table.

Table 5-3: Binding Rate Values in the Run List Table

Parameter Description

Report point (s) Specifies a time point at which to report signal for all samples in
the graph.
« Add—Adds a report point to the table.

+  Remove All—Removes all the report points from the
table.

Index Numbered order of the curves processed. The index is useful to
sort back to the original order.

Show Controls whether the curve is displayed in the Run Data win-
dow.
Analyze Allows you to analyze the results. If not checked, this box

excludes the sample from further analysis.

Ref. Designates a sample for reference subtraction. If a single sam-
ple is chosen, that will be subtracted from all other sample
curves. If multiple samples are chosen as reference, the average
will be subtracted from all other sample curves.

Sample ID The sample ID entered during experiment setup.

Conc. (ng/ml) The molar concentration of the sample used in the association
step. The molar concentration is entered by the user or com-
puted by the molarity calculator during experiment setup.

Binding rate (hnm/s)  The rate of sample binding to the biosensor computed by the
BLItz Pro software using the binding rate equation specified.

Run time (s) The duration of data analysis seconds.

Shaker speed (rpm) The sample platform orbital shaking speed (rotations per min-
ute). This value is set in File > Options.

Integration Reports the time intervals the spectrometer was exposed to
light in acquiring the data.
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Table 5-3: Binding Rate Values in the Run List Table (Continued)

Parameter Description

Biosensor Type The biosensor chemistry utilized in the experiment. By default,
Protein A is used.

Information Information about the biosensor that was entered in the BLItz
system.
Status Indicates if a run is interrupted. For example, if a user stops a

run, the status is shown as “Terminated by User”.

Export to CSV Exports the data in the graph to .csv files, one for each sample.

Create Report Creates a report of the experiment in a PDF file format.

17. Click Save to save your experiment.
Result

In just a few minutes, you have measured the specific concentration of protein in your
unknown samples.

RUNNING A BASIC KINETICS EXPERIMENT

When using the starter kit to perform a Basic Kinetics experiment, follow the instructions
provided below for mouse IgG samples binding Protein A biosensors.

To measure kinetic parameters for your ligand-analyte interactions on the BLItz system con-
sider these guidelines:

+ Ligand indicates the binding partner loaded on the biosensor. Analyte refers to the
binding partner present in solution.

« The Basic Kinetics mode is appropriate for use when the ligand has previously been
loaded on the biosensor, either as provided by Pall ForteBio, or loaded offline on the
bench top, or loaded on BLItz system in a previous experiment.

« Perform baseline and dissociation steps in an microcentrifuge tube. Perform associa-
tion steps in either drop holder or tube for Duration of 5 minutes or less. When asso-
ciation step duration is more than five minutes, perform step in microcentrifuge
tube.

« Use 250 uL of reagent in microcentrifuge tube and 4 pL of reagent in drop holder.

«  When optimizing experiment conditions for measuring kinetic constants for a bind-
ing interaction, use fewer analyte concentrations distributed over the range of
100xKp to 0.01xKp. After optimizing experiment conditions, populate more concen-
trations to maximize reliability of the measured kinetic constants.
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+ Input concentration and molecular weight values, or, the molar concentration values
for the analyte samples used. The BLItz Pro software needs these values to calculate
kinetic constants.

+ Keep the shaker in Enable mode for all kinetics experiments. In File > Options, leave
the shaker speed at the default setting of 2200 rpm for all kinetics experiments.

« Use an appropriate biosensor type from Pall ForteBio’s list of off-the-shelf biosensors.
If one is not readily available, you can prepare a custom biosensor by loading your
ligand on any one of the biosensors available.

+ For the baseline step, duration of 30 to 60 seconds is typically recommended. You
may modify this time as desired to achieve a stable Baseline before moving to the
Association step.

« The duration for Association and Dissociation steps should be optimized based on
the concentration of your analyte samples and the expected affinity of the interac-
tion. Typically, high affinity interactions can require longer dissociation times.

« Always include a reference sample in your experiment to correct for background sig-
nal.

« Always input experiment info first and click Next. Follow the on-screen prompts to
add reagents to the appropriate sample locations and to mount biosensor on the
BLItz system.

- Tofita curve to the data, choose from the available options. To learn more about the
differences between local and global fitting, consult available literature or contact
BLItz technical support.

In this sample Basic Kinetics experiment, you will develop a series of real-time data graphs
for multiple concentrations of mouse IgG analyte binding to pre-loaded Protein A ligand on
the Protein A biosensors. You will analyze the collected data to measure kinetic constants
(ka kg, Kp). You will use 4 pL of sample on the drop holder for the association step and
250 uL of sample diluent in the tube for baseline and dissociation.

Everything you need is in the demo kit:

+ Protein A biosensors

« mlgG stock (10 mg/mL)

+  Sample diluent

« 96-well, black flat-bottom microplate

+ Black 0.5 mL microcentrifuge tubes
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To run a Basic Kinetics experiment:

1. Click the Basic Kinetics icon l/_\ to display the default Basic Kinetics mode
(Figure 5—44), Basic Kinetics

Basic Kinetics

Have you hydrated your biosensor?
Hydrate biosensors prior to use for a minimum of 10 minutes. Hydration time (min): 10 =

Hydrate Biosensor

Enter your Experiment Settings

Experiment Name: _
New Experiment

Description:

Enter your Run Settings

Sample ID: Concentration: pgfml -
Biosensortype: SA (Streptavidin) - Molecular Weight: kD
Shaker: [Enable - Malar Concentration: @
Step Type Dwuration (s) | Position
1 k- Baseline 30 T Tube
2 | Association d Drop S durati
. - un duration:
3 k. Dissociation 120 T Tube ST e

Figure 5-44: Basic Kinetics Mode

Preparation

2. Ensure that all reagents to be used on the BLItz system are warmed to room tempera-
ture.

3. Hydrate five (5) biosensors, as described in “Defining Experiment Types” on page 41.

4. Prepare mlgG sample dilutions:
Using the mlgG stock (10 mg/mL), perform the following dilutions:
+ Step 1—20-fold dilution: 4 uL mlgG stock + 76 yL sample diluent for a [mIgG] =
0.5 mg/mL. Label this as “Stock A"

+ Step 2—50-fold dilution: 4 pL Stock A + 196 pL sample diluent for a [migG] =
10 pg/mL

+ Step 3— 2-fold dilution: 50 uL of 10 ug/mL + 50 pL sample diluent for a [mIgG] =
5 pg/mL

« Step 4—2-fold dilution: 50 pL of 5 ug/mL + 50 pL sample diluent for a [mIgG] =
2.5 pg/mL

+ Step 5—2-fold dilution: 50 pL of 2.5 pg/mL + 50 pL sample diluent for a [mIgG] =
1.25 pg/mL
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NOTE: migG samples will be run in this order:
e Run 1: sample blank

Run 2:1.25 ug/mL

Run 3:2.5 ug/mL

Run 4:5 ug/mL

Run 5: 10 ug/mL

Run Kinetics Experiment

5. Input Run Settings per Figure 5-45 and click @ ‘

Enter your Experiment Settings E
Experiment Mame: Basic Kinetics Demo

New Experiment

Description: Kinetics of binding of mouse IgG analyte to Protein A ligand

Enter your Run Settings

Sample ID: Sample Blank Concentration: a ug/ml

Biosensor type: Protein A - Molecular Weight 150 kD

Shaker: [Enable - Molar Concentration: 0 @

Step Type Dwuration (s) | Position

1 k- Baseline 30 T Tube
2 | Association 6 Drop
Run duration:

3 k. Dissociation 300 T Tube -~ 1030 Run 1

Figure 5-45: Entering Run Settings

Table 5-4 lists and defines the step types for Basic Kinetics experiments.

Table 5-4: Step Types—Basic Kinetics Experiments

Option Description

Baseline Can be used to align the data. Select this step type when establishing
the biosensor baseline in the presence of buffer. This step can be per-
formed with no flow (0 rpm). However, if the baseline step directly
precedes an association step, perform the baseline step at 1,000 rpm.

IMPORTANT: An experiment MUST include a baseline

o step followed by a set of association/dissociation steps
to be analyzed. The data analysis software recognizes
the baseline/association/dissociation set of steps.
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Table 5-4: Step Types—Basic Kinetics Experiments (Continued)

Option Description

Association Calculates the kg, Select this step type when binding the second
protein of interest (analyte) to the biosensor. This step should be per-
formed at 1,000 rpm.

Dissociation Calculates the ky. Select this step type when monitoring the dissocia-
tion of the protein complex. This step should be performed at
1,000 rpm.

NOTE: You can change the position of the Position

e defaults (Figure 5-46): click the Position field to
change the position. All concentrations should use the
same position for each step type.

Step Type Duration (s) | Position

1 ke Baseline U Tube

? ¥ Associgtion 120 & Drop
3 Lk Dissociation 120 T Tube

Figure 5-46: Step Type Default Settings

6. Follow the on-screen instructions (Figure 5-47).

User Action Required

User Action Required 1
Step 1: Baseline Step 1: Baseline @ :

Open the cover. Load the tube containing buffer.
Load a biosensor and close the cover.

Figure 5-47: User Action Required—Experiment Operation

7. Ensure that the sample diluent (4 uL in the drop holder) or (250 pL in the tube) are avail-
able for reading (Figure 5-48).

Figure 5-48: Perform Baseline and Dissociation Measurements in Tube and Association Measurement in
Drop Holder

8. Load the Protein A biosensor on to the biosensor mount; give it a final quarter-turn
upward twist to ensure a snug fit (Figure 5-49).

BLItz User Guide



page 72 Chapter 5: Working with Experiments

Figure 5-49: Mounting a Biosensor

9. Move the slider to the appropriate position to bring either the tube or drop holder to
the read position, as appropriate for each step (Figure 5-50):

a. left position for Baseline
b. right position for Association

c. left position for Dissociation

Figure 5-50: Moving Slider to Bring the Drop Holder or Tube to the Read Position

10. Close the BLItz system cover to start data acquisition each time the BLItz Pro software
prompts you (Figure 5-51).

Figure 5-51: Closing the BLItz System Cover

Data is collected in real-time on screen. The sensorgram (Figure 5-52) displays the
results after the first run.

0 50 100 150 200 250 300 350 400 450 500 550 600
Time (sec)

Run 1

Figure 5-52: Data for Run 1 Collected in Real-Time

After the run, a Save As dialog box displays and prompts you to save the experiment
file (Figure 5-53).
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& Saveds - ot
@ 'vl » BlLitz Demo » Demo Results w {49 Wl Search Demo Results Fe |
p
Organize » MNew folder = - [7)
[ Favorites [ em o d Typ
B Desktop = .
& Downloads
., Recent Places
Bl Desktop
w4 Libraries
= Documents
o' Music
=/ Pictures
a Videos e
File name: Untitled.dataset i
Save as type: | BLitz Files (".dataset) |
e
= Hide Folders [ swe | [ Concel

Figure 5-53: Saving Dataset File

11. Enter a file name and Save the dataset.

12. Lift the cover, discard the used biosensor, wipe the drop holder with a swab or Kimwipe
(Figure 5-54), and rinse 3X with sample diluent—wiping each time with a swab or Kim-
wipe.

The best way to rinse 3X with sample diluent is to take, at least, 20 ulL of buffer
e in a pipet and add small aliquots into the drop holder followed by blotting
with a Kimwipe.

-
;".:!‘
Figure 5-54: Wiping the Drop Holder with a Kimwipe

13. Perform subsequent sample runs, repeating steps 4 to 12 for each concentration:
Run 2: 1.25 pg/mL

Run 3: 2.5 pg/mL
Run 4: 5 pg/mL
Run 5: 10 pg/mL
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Data

14. Observe the Run data and save.
The sensorgram displays the results after five (5) runs (Figure 5-55).

0 50 100 150 200 250 300 350 400 450 500 550 600
Time (sec)

Figure 5-55: Observing Run Data

15. Select the settings in Figure 5-56 and click Analyze to display the results in Figure 5-57.

Analysis Step Correction Fitting (1:1)
[¥] Start of association 0 Local
[¥] Start of dissociation @ Global A
nalyze

Figure 5-56: Analysis Settings—Step Correction and Fitting (1:1)

The Step Correction feature corrects misalignment between two steps due to system
artifacts. The association step can be aligned to the dissociation step or to the baseline.

.+ Start of association—Moves the association step on the Y axis to align the
beginning of the association step with the end of the adjacent baseline step.

.+ Start of dissociation—Moves the dissociation step on the Y axis to align the
end of the adjacent association step with the beginning of the dissociation step.

35 e e
3.0 o
25 ) // —— e —
€ =
E 20 .
=] .
= —
15 - e ————————
z y p——
1.0 s e
05 v d
W s
T —
05
o 50 100 150 200 250 300 350 400 450 500 550 600
Time (sec)
2 5ugmlL 5 ugiml 10 ugiml 1.25 ug/ml

Figure 5-57: Analysis Results—Red Line Overlying Data Are Curve Fits
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A model represents the mathematical model that is used to generate the fitted view.
The Fitting 1:1 model fits one analyte in solution binding to one binding site on the sur-
face. The Fitting 1:1 model can be one of the following options:

- Fitting-Local—If this option is selected, the BLItz computes kinetic constants for
each curve. The constants that are calculated depend on the steps that are ana-
lyzed (Association only, Dissociation only, or Association and Dissociation).

- Fitting-Global (Full)—If this option is selected, an analysis includes all of the
binding curve datain the group and the BLItz generates kinetic constants for the
entire group. The kinetic constants that are calculated depend on the model
selected.

You have just generated binding curves for mlgG against Protein A and a table of

kinetic constants (Figure 5-58). Table 5-5 lists and defines the binding rate values.

Index| Sample ID| Conc. (nM)| Information| KD (M) | ka (1/Ms)| ka Error| kd (1/s) | kd Error | Rmax| Rmax Error| R equilibrium

blank 0

2 25ug/mL 1667 356e-9 1.235eb 3467e2 4.398e4 25396 446 001916 3675
% bug/mL 3333 356e-9 1.235eb 3467e2 4.398e4 253%e6 4577 0.01420 4135
4 10ug/mL 6667 356e-9 1.235eb 34672 4.398e4 253%e-6 4622 0007895 4387
5 1.25ug/mL 8.333 356e-9 1.235eb 3467e2 4.398e4 25396 4128 0.02068 2892

Figure 5-58: Binding Curve Results for mlgG against Protein A and Kinetic Constants

Table 5-5: Binding Rate Values in the Run List Table

Parameter Description

Index Numbered order of the curves processed. The index is useful to sort
back to the original order.

Sample ID The sample ID entered during experiment setup.

Conc. (nM) Concentration of analyte.

Information  Information about the biosensor that was entered.

Kp (M) Measured affinity of interaction; affinity constant in Molar.

k, (1/Ms) Association rate constant.

k, Error Calculated standard error in the measured association rate constant.
kq(1/s) Dissociation rate constant.

kq (Error) Calculated error in the measured dissociation rate constant.

X2 Measure of the goodness of curve fitting (not directly related to a

parameter estimate). It is the sum of squared deviations, where the
deviation is the difference between the actual data point and the fitted
curve. Values close to zero indicate a good curve fit.

R2 The coefficient of determination (COD). It is an estimate of the good-
ness of the curve fit and is not directly related to the estimate of a spe-
cific parameter. Values close to 1.0 indicate a good curve fit.
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Table 5-5: Binding Rate Values in the Run List Table (Continued)

Parameter Description

Rmax Maximum response determined from the fit of the binding data.

Rmax Error Calculated standard error in Rmax.

Requilibrium  Calculated response at equilibrium that is determined from a fit of the
binding data.

Result

You have now generated rate constants and affinity constant for the mouse IgG2-Protein A
binding interaction. Congratulations!

With this, your experiment is complete. We hope that BLItz's powerful experiment features
combined with its simplicity is what you are looking for in your work.

RUNNING AN ADVANCED KINETICS EXPERIMENT

The Advanced Kinetics mode allows users to monitor the kinetics of a binding interaction
by first loading one of the binding partners on a biosensor followed by probing a sample
that contains the second binding partner. A typical experiment data graph is shown in

Figure 5-59.

-]

5
?4
/
»3 |
i | RLoading first Association and dissociation of
i | binding partner second binding partner

|
1 |
0
0 50 100 150 200 250
Time (sec)
Run 2 Run 3 Run 4

Figure 5-59: Advanced Kinetics Data Graph

The first protein can be bound to a biosensor in different ways. Human and Mouse antibod-
ies or fc-fusion proteins can be bound to the Anti-human capture (AHC) and Anti-murine
capture (AMC) biosensor, respectively. GST-fusion proteins can be bound to the Anti-GST
biosensor. Other proteins that are functionalized with biotin can be bound to the Streptavi-
din biosensor. Unmodified proteins can be bound covalently to the 2nd generation amine
reactive (AR2G) biosensor.

The Advanced Kinetics mode can be used to perform kinetic analysis of ligand-analyte
interactions where the ligand is first loaded on biosensors on the BLItz system followed by
monitoring the association and dissociation of analyte to the ligand. In addition, the
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Advanced Kinetics mode can be used to set up custom binding assays involving multiple
binding steps, such as the formation of a sandwich complex (capture antibody-antigen-sec-
ondary antibody).

The Initial Baseline (Figure 5-60) can typically be of 30 or 60 seconds duration, or until sta-
ble baseline is reached in the medium you choose for your experiment. The initial baseline
is performed in the tube. The loading step allows you to load your ligand on the biosensor.
The loading step can be performed on different biosensors listed in the Biosensor type
field.

Step Type Duration (s) | Position Add Step
1 [E= Initial Baseline - [30 T Tube

2 |/ Loading 120 & Drop
3 k- Baseline 30 T Tube
4 ¥ Association 120 & Drop
5k Dissociation 120 T Tube

Figure 5-60: Advanced Kinetics—Step Type List

Table 5-6 lists the type of ligand required for loading to the biosensor.

Table 5-6: Required Ligands

Biosensor Type Required Ligand

Streptavidin Biotin-tagged proteins, oligos, peptides
Super Streptavidin Biotin-tagged proteins, oligos, peptides
Anti-GST GST-fused proteins

Anti-hlgG Fc Capture (AHC) Human IgG, human Fc fusion proteins
Anti-mlgG Fc Capture (AMC) Mouse IgG, mouse Fc fusion proteins

Amine reactive 2nd generation (AR2G) Proteins, oligos, peptides

Amine reactive (AR) Proteins, oligos, peptides

Aminopropylsilane (APS) Proteins, peptides

To prepare biotin-tagged proteins, follow the minimum biotinylation ratio method
described in Technical Note 28, Biotinylation of Protein for Immobilization onto Streptavidin
Biosensors, available at www.blitzmenow.com/literature.html.

To load ligand on AR and AR2G biosensors, the Amine Coupling Second Generation
Reagent Kit is required.

A Baseline step follows the loading step to establish a new baseline before association and
dissociation steps with the analyte. In the Association step, the analyte in solution binds to
the ligand on the biosensor. In the Dissociation step, the analyte bound to the biosensor
dissociates into solution.
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Table 5-7 lists the applicable rules when performing an Advanced Kinetics experiment.

Table 5-7: General Step Type Rules for an Advanced Kinetics Experiment

Step Type Position

Initial Baseline Tube

Loading Drop holder or Tube if Duration is less than 300 seconds; only Tube
if more than 300 seconds.

Baseline Tube

Association Drop holder or Tube if Duration is less than 300 seconds; only Tube
if more than 300 seconds

Dissociation Tube

Custom Drop holder or Tube if Duration is less than 300 seconds; only Tube
if more than 300 seconds.

NOTE: In Advanced Kinetics, to create a successful experiment, there must (at a
minimum) be Initial Baseline, Association, and Dissociation step,
included in that order.

To run an Advanced Kinetics experiment, you will need:

+ Biosensors (choice of biosensor made by user)

+ Ligand for loading on biosensor

« Analyte or sample (one or more concentrations, depending on type of experiment)
+  Sample diluent

+  96-well, black, polypropylene flat-bottom microplate

« microcentrifuge tubes
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To run an Advanced Kinetics experiment:

1. With the software launched, on the left pane, click the Advanced Kinetics icon E‘
to display the default Advanced Kinetics mode (Figure 5-61). Avanced Gt

Advanced Kinetics

Have you hydrated your biosensor?

Hydrate biosensors prior to use for a minimum of 10 minutes. Hydration time (min): 10 =

Hydrate Biosensaor

Enter your Experiment Settings

Experiment Name:

New Experiment
Description:
Enter your Run Settings
Sample ID: Concentration: pgfml -
Biosensortype: SA (Streptavidin) - Molecular Weight: kD

Shaker: [Enable v] Malar Concentration: @
Step Type Dwuration (s) | Position Add Step

[1]k= initial Baseline 30 U Tube =

2 |/ Loading 120 & Drop e S
3 k. Baseline 30 T Tube Move Up
4 | Association 120 & Drop =

5 k. Dissociation 120 T Tube Move Down
Run duration:

>07.00 Run 1

Figure 5-61: Advanced Kinetics

Preparation
2. Hydrate biosensors, as described in the “Defining Experiment Types” on page 41.

3. Prepare ligand solution for loading step. Perform dilution as required to bring the
ligand solution to a concentration of 10-50 pg/mL.

NOTE: When performing kinetics experiments on AR and AR2G biosensors,

e two separate Advanced Kinetics experiments are needed. The first Advanced
Kinetics experiment should be performed according to the following protocol
to load protein on the biosensors:

a. Set up an experiment with the steps in Figure 5-62. In Step 2, activation of the
hydrated biosensor with EDC/Sulfo NHS mixture is performed in a tube. In Step 3,
the ligand is loaded on the activated biosensor either in the drop holder or the tube.
In Step 5, the biosensor is quenched with quenching solution.
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Step Type Dwuration (s) | Position
1 k= Initial Baseline 15 T Tube
2 BZ Custom 300 T Tube
3 |£ Loading 300 T Tube
4 F Custom 300 T Tube
5 k. Baseline 60 T Tube

Figure 5-62: Step Types for This Experiment

Table 5-8 lists and defines the step types for Advanced Kinetics experiments.

Table 5-8: Step Types—Advanced Kinetics Experiments

Option Description

Baseline Can be used to align the data. Select this step type when establishing
the biosensor baseline in the presence of buffer. This step can be per-
formed with no flow (0 rpm). However, if the baseline step directly
precedes an association step, perform the baseline step at 1,000 rpm.

IMPORTANT: An experiment MUST include a baseline

o step followed by a set of association/dissociation steps
to be analyzed. The data analysis software recognizes
the baseline/association/dissociation set of steps.

Association Calculates the k. Select this step type when binding the second
protein of interest (analyte) to the biosensor. This step should be per-
formed at 1,000 rpm.

Dissociation Calculates the ky. Select this step type when monitoring the dissocia-
tion of the protein complex. This step should be performed at
1,000 rpm.

NOTE: You can change the position of the Position

e defaults (Figure 5-63): click the Position field to
change the position. All concentrations should use the
same position for each step type.

Step Type Duration (s) | Position

1 ke Baseline U Tube

? ¥ Associgtion 120 & Drop
3 Lk Dissociation 120 T Tube

Figure 5-63: Step Type Default Settings
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Table 5-9 lists and describes the available step type functions.
Table 5-9: Step Type Functions—Advanced Kinetics

Task Description

Add Step To add a step type from the list, click the corresponding row in the
Step Type list and click Add Step.

Remove Step To delete a step type from the list, click the corresponding row in the
Step Type list and click Remove Step.

Move Up To move up a step type in the list, click the corresponding row in the
Step Type list and click Move Up.

Move Down To move down a step type in the list, click the corresponding row in
the Step Type list and click Move Down.

Reset To reset a step type from the list, click the corresponding row in the
Step Type list and click Reset. A prompt displays (Figure 5-64) that all
steps will be reset to default values. If this is the preference, click OK.

Reset Steps

All steps will be reset to default values

Are you sure?

[ Ok H Cancel ]

Figure 5-64: Reset Steps

e NOTE: All biosensors needed for the experiment should be loaded one after
another using this procedure and kept hydrated in solution until ready for the
binding experiment with analyte.

b. The analyte binding kinetics experiment can now be performed using the Basic
Kinetics mode.

4. Prepare analyte solutions.
Run Experiment

5. Input Run Settings per Figure 5-65 and click @ ‘
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Enter your Experiment Settings
Experiment Mame: Binding Kinetics Experiment

New Experiment
Description: Biotinylated ligand-analyte binding experiment

Enter your Run Settings

Sample ID: Ligand-Analyte Concentration: 10 ug/ml

Biosensortype: SA (Streptavidin) - Molecular Weight 150 kD
Shaker: [Enable v] Molar Concentration:  66.67 @
Step Type Dwuration (s) | Position Add Step
1 k= Initial Baseline 30 T Tube
2 |/ Loading 300 & Drop
3 ke Basell.ne. U Tube
4 | Association 300 & Drop
5 k. Dissociation 600 T Tube
Run duration:
>2100 Run

Figure 5-65: Entering Run Settings

6. Follow the on-screen instructions. For instructions on performing the functions
prompted by the software, refer to “Basic Functions of the BLItz System” on page 8.

7. To clean the drop holder during the experiment, perform the following actions: Lift the
BLItz system cover, discard the used biosensor, wipe the drop holder with a swab or
Kimwipe, and rinse 3X with sample diluent—wiping each time with a swab or Kimwipe.

8. Repeat the experiment for all samples.
9. Save the experiment.

Data Analysis

Run Data

=
h
\

=
]
]

i
i

Bina ng (nm)

o 50 100 150 200 250 300 350 400 450 500 550 600

T (sec)

Run T Run &

Figure 5-66: Observing Run Data from an Advanced Kinetics Experiment

10. Select Step Correction and Fitting (1:1) options and click Analyze to display curve fits
and results.
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MANAGING REPORTS

The BLItz software allows you to manage reports generated from the experiments you pro-
duce.

Generating a Report

To generate a report:

1. Onthe menu bar, click File > Create Report, or in the Run List section, click Create
Report.

2. Confirm the location to which the file will be saved or specify a different location.

3. Click Save.

Viewing Reference-Subtracted Data

If the experiment includes reference biosensors, you can display reference-subtracted data
in the Run Data window by clicking the Reference (Ref.) check box (Figure 5-67) in the
binding chart window. To view raw data, un-check the box.

Run List Reportpaint(s): 0 = Remaove All
Index| Show| Analyze| Ref.| Sample ID| Conc. (ug/ml)| Calculated Conc.| Binding rate (nm/s)| Run time (s)| Shaker speed (rpm)| Integration (ms})| Biosensor Type| Information| Status
@ @ [ JReference 0 0 0 30 2200 15 Protein A
4 4 I~ Runl 15.6 15.6 0.1079 30 2200 15 Protein A
3 4 4 ™ Run2 625 625 0.4370 30 2200 15 Protein A
4 4 ™ Run3 250 250 138 30 2200 15 Protein A
Before 4
After
Run List Reportpoint(s) 0 = Add Remove All
Index| Show| Analyze| Ref | Sample ID| Conc. (ug/ml)| Calculated Conc.| Binding rate (nm/s)| Run time (s)| Shaker speed (rpm)| Integration (ms)| Biosensor Type | Information| Status
¥ [ [[@]Reference 0 30 2200 15 Protein A
4 4 I~ Runl 15.6 15.6 0.1030 30 2200 15 Protein A
3 4 4 ™ Run2 625 625 0.4385 30 2200 15 Protein A
4 4 ™ Run3 250 250 138 30 2200 15 Protein A
Figure 5-67: Reference Check Box
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Viewing Inverted Data

The data displayed in the Run Data window can be inverted during real-time data acquisi-
tion or data analysis after the experiment has completed. To invert data, right-click the
chart and select Flip Data (see Figure 5-68); disable the check box to return to the default
data display.

Froperties. ..

Export Data, .

Undo Zoam

® X Fullseale

[ I S R~ XY

Binding (nm)

% Autoscale

——

0 10 20 30 40 a0 B0 70 ¥ Autoscale 100 110
Time (sec)

v Flip all Data

Figure 5-68: Data Inverted Using Flip Data Function

Table 5-10 lists and defines the right-click menu commands for the Run Data window.

Table 5-10: Run Data Right-Click Menu Commands

Menu Command Description

Properties Allows for adding a title and subtitle to the graph.
Allows selection of the following for the graph legend:
+ Run Index (selected by default)—Numbered order of the
curves processed. The index is useful to sort back to the origi-
nal order.

«  Sample ID—The sample ID entered during experiment setup.

« Concentration—The molar concentration of the sample used
in the association step. The molar concentration is entered by
the user or computed by the molarity calculator during exper-
iment setup.

- Biosensor Type—The type of biosensor chemistry.

e NOTE: Text for Sample ID, Biosensor Type, or Con-
centration js taken from the initial experiment setup,
and must be entered before the experiment is started.

Set Color Sets the color for the data results.
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Table 5-10: Run Data Right-Click Menu Commands (Continued)

Menu Command Description

Export Data Allows for export of the graph image or the data.
« Forimage export, the file format, image size and resolution,
and destination can be specified (Figure 5-69).

Exporting - (|
Export
@EMF  ©OWMF ©BMP (DJPG (D PNG () Text / Data
Export Destination
@ ClipBoard
() File Browse
() Printer
Export Size
() Millimeters @ Inches () Paints |
Width: & / 25 Inches
DP: 300~ [7]Large Fort Cancel

Figure 5-69: Image Export Settings

- For data export as text, additional options for selecting all
data or selected data, and format for importing to other soft-
ware can be selected (Figure 5-70). This is often done by
selecting All Data, Table under Export style and Subsets/
Points under Row vs Column in the Export dialog and then
clicking the Export button (Figure 5-70). This data can then
be pasted into Microsoft® Excel® or other software packages
for additional analysis.

Export... .. )]
Select Subsets and Points Export What
@ Al Data () Data
@ Selected Data (@) Data and Labels
Subsets to Export: Data to Export
Run 1 (@) X fods Value, Y Axis Value
Run 2
Run 3
Run 4
Run 5
Export Style
@ List () Table
| Delimited Row vs Column
; - - ! |
HoEE EaTE @ Tab (@) Subsets./FPoints
; i () Comma Points/Subsets |
3
E 1 Numeric Precision
E_ (@) Curertt Precision Export
: © Maimum Precision

Figure 5-70: Image Export Settings
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Table 5-10: Run Data Right-Click Menu Commands (Continued)

Menu Command Description

X Fullscale Scales the x axis to in all graphs to the range needed to accommo-
date all of the data.

X Autoscale Scales the x axis to the data in each graph.

Y Fullscale Scales the y axis to in all graphs to the range needed to accommo-
date all of the data.

Y Autoscale Scales the y axis to the data in each graph.

Flip All Data Inverts signals from positive to negative or from negative to positive.
This is used most often when the observed nm shift is negative due
to the presence of large analytes, such as phage, cells, and lipoparti-
cles on the biosensor surface.
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APPENDIX A:

Running the BLItz Pro Software
on Computers Running Octet
Systems

Running Only the BLItZ SysStem ... .ottt et e e eans 88

Running Experiments on Octet and BLItz Systems .........ccoviiiiiiiiniiiinininennn. 88
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For Octet™ customers who also purchase a BLItz™ system, this section addresses the proce-
dures with having the two systems share a computer. Those Octet customers include:

« Those that have the Octet v4.x software
« Those that have a relatively new v5.x. and v6.x software

- Those that have v7.0, v8.x and the latest v9.0 software

NOTE: To have BLItz and Octet systems share a computer seamlessly, update

e your Octet software to v7.0.1.3 or higher. If you do not wish to update your
Octet software, earlier versions of Octet software can still run on the same
computer alongside BLItz Pro software. The following sections describe how to
perform the procedure.

RUNNING ONLY THE BLITZ SYSTEM

To run ONLY the BLItz system on the computer:

1. Ensure that the Octet software is closed. If the Octet software is running, close it.
2. Connect the BLItz system power and plug its USB cable into the computer.

3. Turn on the BLItz system.

4. Double-click the BLItz Pro desktop icon é

The BLItz Pro software is launched, the BLItz system will initialize, and an “Initializing”
prompt will display. The BLItz system’s front light will blink; after the initialization pro-
cess completes successfully, the “Initializing” prompt will close automatically, and the
light will stop blinking.

If no error message appears, you can start an experiment on the BLItz system; other-
wise, refer to “Troubleshooting” on page 91.

RUNNING EXPERIMENTS ON OCTET AND BLITZ SYSTEMS

To run experiments on both an Octet system and a BLItz system on the same computer:

1. Ensure that the Octet software is closed, that the BLItz system is powered off, and that
the BLItz Pro software is closed.

2. Double-click the Octet software desktop icon to launch the Octet software.

The Octet software is launched, after the Octet system initializes properly. A “Ready.
Date, Time” statement displays on the Instrument Status window (Figure A-1).
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# Instrument Status Window

a [1] %/ aiting ta initialize. 12/8/2011, 4:24:48 PM
a [2) Initializing.... 12/8/2011, 4:24:43 PM
a [3) Instrument initialized. 12/8/2011, 4:25:05 PM
a [4) Ready. 12/8/2011, 4:25:06 PM

Auto scroll to battam Save to file

Figure A-1: Instrument Status Window—Octet System

3. Turn on the BLItz system.
4. Double-click the BLItz Pro desktop icon é .

The BLItz Pro software is launched, the BLItz system will initialize, and an “Initializing”
prompt will display. The BLItz system’s front light will blink; after the initialization pro-
cess completes successfully, the “Initializing” prompt will close automatically, and the
light will stop blinking.

If no error message appears, you can start an experiment on the BLItz system; other-
wise, refer to “Troubleshooting” on page 91.

CAUTION: While running an experiment on an Octet system, do not click the

o Stop icon X to abort the experiment. If this occurs: 1) close the Octet soft-
ware and the BLItz Pro software, 2) power off the BLItz system, and 3) then re-
launch the Octet software.

CAUTION: On the Octet software, do not click Instrument > Reset menu
o command to reset the Octet system. If an experiment was aborted on the

Octet software: 1) close the Octet software and the BLItz Pro software, 2)

power off the BLItz system, and 3) then re-launch the Octet software.
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APPENDIX B:

Troubleshooting

Troubleshooting BLItz System Errors with an Octet System .............ccovvivivninne... 92
Scenario 1T—The BLItz System Cannot Initialize Successfully ........................ 92
Scenario 2—The BLItz System Is Not Recognized ...............cccoiiiiiiiiinin.n. 92

This appendix describes how to troubleshoot some scenarios of BLItz system errors.
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TROUBLESHOOTING BLITZ SYSTEM ERRORS WITH AN OCTET SYSTEM

Scenario 1—The BLItz System Cannot Initialize Successfully

When you launch the BLItz Pro™ software, the BLItz™ system cannot initialize successfully
(the BLItz system light keeps blinking), and either of the following error messages display

(Figure B-1).
BLitz Pro == BLitz Pro =5
I_\ Cannot find 1 spectrometer. Only found 0. I_\ Spectrometer does not match EEPROM setting.

——

Figure B-1: Error Message Possibilities

How to Recover
1. Close the BLItz Pro software.
2. Switch off the BLItz system.

3. Ensure that the USB cable is connected properly between the BLItz system and the
computer.

4. Switch on the BLItz system. Wait for five (5) minutes.

5. Turn on the BLItz Pro software.

e NOTE: If the symptom still exists, restart steps 1 to 5 above.

Scenario 2—The BLItz System Is Not Recognized
When you launch BLItz Pro software, the following prompt (Figure B-2) displays.

The instrument could not be opened.
Would you like to continue in simulation mode?
Retry
[T] Always open in simulation mode if not connected to an instrument

Figure B-2: Simulation Mode Prompt
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How to Recover
1. Close the BLItz Pro software.

2. Ensure that the BLItz system is powered on (the light is on) and that the power and USB
cable are properly connected to the BLItz system and computer.

3. Re-launch the BLItz Pro software until the system initialization completes successfully
(no error message displays).
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